Contents

Printer Parts and Functions

Printer Parts and Control Panel Functions ..................... 1

Safety Instructions

Important Safety Instructions ........................................ 5
A Few Precautions ..................................................... 6
  When using the printer ............................................. 6
  When handling the ink cartridges ................................. 7
  When choosing a place for the printer ......................... 8
ENERGY STAR Compliance ............................................. 9
For United Kingdom Users ........................................... 9
  Use of options ..................................................... 9
  Safety information ............................................... 9
Warnings, Cautions, and Notes ..................................... 10

Chapter 1 Paper Handling

Loading Plain Paper .................................................. 1-1
Loading Special Paper and Other Media ........................ 1-2
  About special media cleaning sheets ............................. 1-5
Loading Envelopes ................................................... 1-5
  Storing EPSON Photo Paper .................................... 1-6

Chapter 2 Printing with Windows

Printer Software Introduction ..................................... 2-1
  Getting more information ....................................... 2-1
  Accessing the printer software ................................ 2-2
Making Changes to Printer Settings ............................... 2-3
  Making the Media Type setting ................................ 2-4
Chapter 3 Checking Printer Status and Managing Print Jobs for Windows

Using the Progress Meter .................................................. 3-1
Epson Printing Tips .................................................. 3-2
Error messages .................................................. 3-2
Using EPSON Spool Manager ........................................ 3-3
For Windows Me, 98 and 95 ........................................ 3-3
Using EPSON Status Monitor 3 ...................................... 3-3
Accessing EPSON Status Monitor 3 ......................... 3-3
Viewing information in EPSON Status Monitor 3 .... 3-4
Chapter 4 Using the Printer Software for Macintosh

Printer Software Introduction ........................................... 4-1
Making Changes to Printer Settings .................................... 4-1
  Making the Media Type setting ........................................ 4-2
  Using the Automatic mode ............................................ 4-6
  Using the PhotoEnhance mode ........................................ 4-6
  Using the Custom mode .............................................. 4-8
  Changing the page setup ............................................. 4-11
Modifying the page layout ............................................. 4-15
  Fitting your document to the paper size ........................... 4-16
  Printing two or four pages on one sheet ......................... 4-17
  Printing posters .................................................... 4-18
  Printing a watermark on your document ......................... 4-21
Setting the Print Time .................................................. 4-24
  Saving spool data as a file ....................................... 4-25
Previewing your printout .............................................. 4-26
Using the Printer Utilities ............................................. 4-28
  EPSON StatusMonitor ............................................... 4-28
  Nozzle Check ...................................................... 4-29
  Head Cleaning ..................................................... 4-29
  Print Head Alignment ............................................... 4-29
  Configuration ...................................................... 4-30

Chapter 5 Checking Printer Status and Managing Print Jobs for Macintosh

Using EPSON StatusMonitor ............................................. 5-1
  Accessing EPSON StatusMonitor .................................... 5-2
  Using the Configuration Settings dialog box .................... 5-2
Using EPSON Monitor3 .................................................. 5-4
  Accessing EPSON Monitor3 ......................................... 5-4
  Managing print jobs using EPSON Monitor3 .................... 5-5
  Changing the priority of print jobs ............................... 5-6

Chapter 6 Setting Up Your Printer on a Network
Chapter 7 Replacing Ink Cartridges

Using the Printer's Control Panel. 7-1
Using the Status Monitor. 7-7

Chapter 8 Maintenance

Checking the Print Head Nozzles 8-1
Using the Nozzle Check utility 8-1
Using the control panel buttons 8-2
Cleaning the Print Head 8-3
Using the Head Cleaning utility 8-4
Using the control panel buttons 8-7
Aligning the Print Head 8-8
For Windows users 8-9
For Macintosh users 8-9
Cleaning the Printer 8-10
Transporting the Printer 8-11
Updating and Uninstalling Software 8-12
Updating to Windows 98 8-12
Updating Windows Me 8-12
Updating the driver in Windows 2000 and NT 4.0 8-13
Uninstalling the printer driver 8-13

Chapter 9 Troubleshooting
Correcting USB Problems ........................................... 9-1
    Printer does not work correctly with the USB cable .... 9-1
    Operating system ............................................. 9-2
    Printer software installation ............................... 9-2
    USB driver installation .................................... 9-3
    The Device Manager menu (for Windows Me and 98) .... 9-4
Diagnosing the Problem ............................................ 9-7
    Error indicators ............................................... 9-8
    Status Monitor ............................................... 9-9
    Running a printer operation check ....................... 9-10
Cancelling Printing .................................................. 9-12
    For Windows users ......................................... 9-12
    For Macintosh users ....................................... 9-13
    Using EPSON Spool Manager ............................... 9-14
Print Quality Could Be Better .................................... 9-15
    Horizontal banding ....................................... 9-15
    Vertical misalignment or banding ....................... 9-15
    Color gaps .................................................. 9-16
    Incorrect or missing colors .............................. 9-17
    Blurry or smeared printout ............................... 9-18
Printouts Are Not What You Expected ............................ 9-19
    Incorrect or garbled characters ....................... 9-20
    Incorrect margins ......................................... 9-20
    Inverted image ............................................. 9-21
    Blank pages print ......................................... 9-21
    Printout has smears on the bottom edge ................ 9-22
    Printing is too slow ....................................... 9-22
Printer Doesn't Print ............................................. 9-22
    All lights are off ......................................... 9-23
    Lights came on and then went out ....................... 9-23
    Only the power light is on ................................ 9-23
    Error light is flashing or on ......................... 9-24
    Error light is on and power light is flashing ....... 9-25
Paper Doesn't Feed Correctly .................................... 9-25
    Paper doesn't feed ....................................... 9-26
    Multiple pages feed ..................................... 9-26
    The paper jams ............................................. 9-27
    Paper isn't ejected fully or is wrinkled ............. 9-28
Chapter 10 Consumable Products

Options .................................................. 10-1
Consumable products .................................. 10-1
   Ink cartridges ....................................... 10-1
   Media types ........................................... 10-1

Appendix A Printer Specifications

Printing .................................................. A-1
Paper ..................................................... A-1
   Paper specifications .................................. A-2
   Printable area .......................................... A-4
Ink Cartridges ......................................... A-6
Mechanical ............................................. A-9
Electrical ............................................... A-9
Environmental ......................................... A-10
Safety Approvals ....................................... A-10
System Requirements ................................. A-11
   For Windows computers ................................ A-11
   For Macintosh computers ............................ A-12

Appendix B Customer Support

Technical Support Web Site ............................ B-1
Regional Customer Services ............................ B-1
   ................................................................. B-8

Glossary
Printer Parts and Functions

Printer Parts and Control Panel Functions

- Sheet feeder
- Edge guides
- Printer cover
- Paper support
- Adjust lever
- Output tray
- Output tray extension
- Ink cartridge clamps
- Print head
- Control panel
Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍀 power</td>
<td>Turns the printer on and off. Clear the printer's memory if pressed twice while the power is on.</td>
</tr>
<tr>
<td>🍀 maintenance</td>
<td>Loads or ejects paper if pressed and released within two seconds. Resumes printing if pressed and released after a paper out error. Performs print head cleaning if pressed for 3 seconds when the error light is off. Moves the print head to the ink cartridge replacement position and charges ink to the printer when ink is out.</td>
</tr>
<tr>
<td>🍀 ink cartridge replacement</td>
<td>Moves the print head to the ink cartridge replacement position and charges ink to the printer.</td>
</tr>
</tbody>
</table>

Lights

<table>
<thead>
<tr>
<th>Light</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍀 power</td>
<td>On when the printer is on. Flashing when printer is receiving data, printing, replacing an ink cartridge, charging ink, or cleaning the print head.</td>
</tr>
</tbody>
</table>

-2 Printer Parts and Functions
<table>
<thead>
<tr>
<th>Error Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="" /></td>
<td>On when the printer is out of paper. Load paper in the sheet feeder, then press the maintenance button to resume printing.</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
<td>On when the paper is jammed. Take all of the paper out of the feeder, then reload the paper. If the light continues to flash, turn off the printer and gently pull all of the paper out of the printer.</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
<td>Flashing when the black or color ink cartridge is nearly empty.</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
<td>On when the black or color ink cartridge is empty. Replace the black ink cartridge or color ink cartridge.</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
<td>Black ink cartridge:</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
<td>T007 (Standard capacity)</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
<td>T010 (Light capacity)</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
<td>Color ink cartridge: T008</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
<td>Flashing when the print head moves to the ink cartridge replacement position. The light will flash faster if the color ink is out than if the black ink is out.</td>
</tr>
</tbody>
</table>
Safety Instructions

Important Safety Instructions

Read all of these instructions before using your printer. Also, be sure to follow all warnings and instructions marked on the printer.

- Do not block or cover the openings in the printer’s cabinet. Do not insert objects through the slots.

- Take care not to spill liquid on the printer.

- Use only the type of power source indicated on the printer’s label.

- Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.

- Avoid electrical outlets controlled by wall switches or automatic timers.

- Keep the entire computer system away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.

- Do not use a damaged or frayed power cord.

- If you use an extension cord with the printer, make sure that the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure that the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.

- Do not attempt to service the printer yourself.
Unplug the printer and refer servicing to qualified service personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the cabinet damaged; the printer does not operate normally or exhibits a distinct change in performance.

If you plan to use the printer in Germany, the building installation must be protected by a 10 or 16 amp circuit breaker to provide adequate short-circuit protection and over-current protection for this printer.

Note for German-speaking users:
Bei Anschluss des Druckers an die Stromversorgung muss sichergestellt werden, dass die Gebäudeinstallation mit einer 10 A- oder 16 A-Sicherung abgesichert ist.

A Few Precautions

Take note of the following when using the printer, handling the ink cartridges, or choosing a location for the printer.

When using the printer

Observe the following:

- Do not put your hand inside the printer or touch the ink cartridges during printing.
- Do not move the print head by hand; otherwise, you may damage the printer.
- Always turn the printer off using the power button. When this button is pressed, the power light flashes briefly and then goes out. Do not unplug the printer or turn off the power to the outlet until the power light stops flashing.
Before transporting the printer, make sure that the print head is in the home (far right) position and the ink cartridges are in place.

**When handling the ink cartridges**

Observe the following:

- Keep ink cartridges out of the reach of children. Do not allow children to drink from or otherwise handle the cartridges.

- Be careful when you handle the used ink cartridges, as there may be some ink remaining around the ink supply port. If ink gets on your skin, wash the area thoroughly with soap and water. If discomfort or vision problems remain after a thorough flushing, see a physician immediately.

- Do not shake an ink cartridge; this can cause leakage.

- Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge unpacked for a long time before use may result in reduced print quality.

- Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use up the ink cartridges within six months of installing them.

- Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

- After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.

- Store ink cartridges in a cool, dark place.

- Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and printing.
In this ink cartridge, the IC chip retains a variety of cartridge related-information, such as the amount of ink remaining, so that a cartridge may be removed and reinserted freely. However, each time the cartridge is inserted, some ink is consumed because the printer automatically performs a reliability check.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

**When choosing a place for the printer**

Observe the following:

- Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The printer will not operate properly if it is tilted or at an angle.

- Leave enough space in front of the printer for paper to be fully ejected.

- Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct sunlight, strong light, or heat sources.

- Avoid places subject to shocks and vibrations.

- Avoid places subject to dust.

- Leave enough room around the printer to allow for sufficient ventilation.

- Place the printer near a wall outlet where the plug can be easily unplugged.
Note for French-speaking users:
Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée facilement.

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this product meets the ENERGY STAR guidelines for energy efficiency.

The International ENERGY STAR Office Equipment Program is a voluntary partnership with the computer and office equipment industry to promote the introduction of energy-efficient personal computers, monitors, printers, fax machines, copiers, and scanners in an effort to reduce air pollution caused by power generation.

For United Kingdom Users

Use of options

EPSON (UK) Limited shall not be liable against any damages or problems arising from the use of any options or consumable products other than those designated as Original EPSON Products or EPSON Approved Products by EPSON (UK) Limited.

Safety information

Warning:
This appliance must be earthed. Refer to the rating plate for voltage and check that the appliance voltage corresponds to the supply voltage.
Important:
The wires in the mains lead fitted to this appliance are coloured in accordance with the following code:

Green and yellow — Earth
Blue — Neutral
Brown — Live

If you have to fit a plug:
As the colours of the mains lead of this appliance may not match the coloured markings used to identify the terminals in a plug, please proceed as follows:

The green and yellow wire must be connected to the terminal in the plug which is marked with the letter E or the earth symbol (\). The blue wire must be connected to the terminal in the plug marked with the letter N. The brown wire must be connected to the terminal in the plug marked with the letter L.

If damage occurs to the plug, replace the cord set or consult a qualified electrician.

Replace fuses only with a fuse of the correct size and rating.

---

**Warnings, Cautions, and Notes**

- **Warnings**
  must be followed carefully to avoid bodily injury.

- **Cautions**
  must be observed to avoid damage to your equipment.
Notes contain important information and useful tips on the operation of your printer.
Loading Plain Paper

Follow the steps below to load plain paper in the printer.

1. Lower the output tray and slide out the extension. Next, slide the left edge guide so that the distance between the edge guides is slightly wider than the width of your paper.

2. Fan a stack of paper, then tap it on a flat surface to even the edges.

3. Load the stack of paper in the sheet feeder with the printable side up and the right edge of the paper resting against the right edge guide. Then, slide the left edge guide against the left edge of the paper.

Note:
- Leave enough space in front of the printer for paper to be fully ejected.
- Always load paper into the sheet feeder short edge first.
Make sure that the paper stack fits under the arrow mark inside the edge guide.

Loading Special Paper and Other Media

You can achieve good results with most types of plain bond paper. However, coated paper and glossy film result in higher quality printouts because these media absorb smaller amounts of ink.

EPSON provides special media that are formulated for the ink used in EPSON inkjet printers. EPSON recommends using media distributed by EPSON to ensure high-quality results. See “Media types” on page 10-1 for a complete list of these products.

When loading special media distributed by EPSON, read the instruction sheets packed with the media first and keep the following points in mind.

- Make sure that the printable side of the paper is facing up when loading media into the sheet feeder. See the instruction sheets packed with the media to determine which side is the printable surface. Some types of media have cut corners to help identify the correct loading direction, as shown in the illustration.
Note:
If you extend the printable area by selecting Maximum as the Printable Area setting in the printer driver, the cut corner on special paper may mar your printout.

- Make sure that the paper stack fits under the arrow mark located on the inside surface of the left edge guide.

- See below for the loading capacities for EPSON special media.

<table>
<thead>
<tr>
<th>EPSON Special Media</th>
<th>Loading Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>360 dpi Ink Jet Paper and Photo Quality Ink Jet Paper</td>
<td>Up to the arrow mark on the left edge guide.</td>
</tr>
<tr>
<td>Photo Quality Ink Jet Cards, Ink Jet Note Cards, and Ink Jet Greeting Cards</td>
<td>Up to 30 index cards. Always place the included support sheet* under the cards.</td>
</tr>
<tr>
<td>Photo Quality Glossy Film</td>
<td>One sheet at a time for best results. Always place a support sheet* or a sheet of plain paper under the glossy film.</td>
</tr>
<tr>
<td>Ink Jet Transparencies</td>
<td>One sheet at a time.</td>
</tr>
<tr>
<td>Photo Quality Self Adhesive Sheets</td>
<td>One sheet at a time.</td>
</tr>
<tr>
<td>Photo Paper</td>
<td>Up to 20 sheets. Always place a support sheet* under the stack of Photo Paper. 200 x 300 mm Photo Paper can only be loaded 1 sheet at a time.</td>
</tr>
<tr>
<td>Photo Stickers 16 and Photo Stickers 4</td>
<td>One sheet at a time.</td>
</tr>
<tr>
<td>Matte Paper-Heavyweight</td>
<td>Up to 20 sheets. Always place a support sheet* under the stack of Matte Paper-Heavyweight.</td>
</tr>
<tr>
<td>Premium Glossy Photo Paper</td>
<td>One sheet at a time.</td>
</tr>
</tbody>
</table>

* Take care not to print on a support sheet that is loaded under special media.
If the paper is curled, flatten it or curl it slightly toward the opposite side before loading. Printing on curled paper may smear your printout, especially when printing with Maximum selected as the Printable Area setting.

If ink smears on your documents when printing on thick media, set the adjust lever to the “+” position.

Note:
- Return the adjust lever to the “0” position before printing on media of normal thickness. Leaving the lever in the “+” position may cause gaps in the printed image.

- When the adjust lever is in the “+” position, make sure that the High Speed check box in the printer driver’s Advanced dialog box is cleared. To clear this check box, you may also need to change the Print Quality setting or align the print head using the Print Head Alignment utility.
If you wish to print on the reverse side of an Ink Jet Card with Maximum selected as the Printable Area setting, flatten the card or curl it slightly toward the opposite side before loading. Set the adjust lever to the “+” position before printing.

**About special media cleaning sheets**

Cleaning sheets packaged with EPSON special media should not be used with this printer. The cleaning function performed by these sheets is not necessary with this type of printer, and the sheets could jam in the printer.

**Loading Envelopes**

When printing on envelopes, please note the following:

- You can load up to 10 envelopes at a time in the sheet feeder.

  **Note:**
  The folding quality and thickness of envelopes varies widely. If the total thickness of the stack of envelopes exceeds 10 mm, press each envelope in the stack flat before loading. If print quality declines when a stack of envelopes is loaded, load one envelope at a time.

- Set the adjust lever to the “+” position.

  **Note:**
  - Return the adjust lever to the “0” position, which is the normal position, after you finish printing on envelopes. Leaving the lever in the “+” position may cause gaps to appear in images that are printed on other media.
  
  - When the adjust lever is in the “+” position, make sure that the High Speed check box in the printer driver’s Advanced dialog box is cleared. To clear this check box, you may also need to change the Print Quality setting.
Load envelopes flap edge first with the flap side down, as shown in the illustration.

Available envelopes sizes are:
No.10, DL, C6, 132 mm × 220 mm

Do not use envelopes that are curled or folded. Flatten envelopes before loading. Avoid using envelopes that are too thin as they may curl during printing.

Select Plain Paper as the Media Type setting in the printer driver.

**Storing EPSON Photo Paper**

Return unused paper to the original package as soon as you finish printing. Also, EPSON recommends storing your printouts in a resealable plastic bag. Keep them away from high temperature, humidity, and direct sunlight.
Chapter 2

Printing with Windows

Printer Software Introduction

The printer software which comes with your printer includes a printer driver and printer utilities. The printer driver lets you choose from a wide variety of settings to get the best results from your printer. The printer utilities help you check the printer and keep it in top operating condition.

If you encounter any problems when using the printer software, refer to the Problem Solver or access to the Technical Support Web Site for help by clicking Technical Support on the Main menu of the printer software.

Note:
Depending on your location, the Problem Solver may not be accessible.

Getting more information

For information on using the printer driver, see “Making Changes to Printer Settings” on page 2-3.

For information on using the printer utilities, see “Using the Printer Utilities” on page 2-30.

Note:
The specific features available in the printer software vary depending on the version of Windows that you are using.

Online help provides more information about the printer software. See “Getting Information Through Online Help” on page 2-37 for instructions on accessing help.
Accessing the printer software

You can access the printer software from most Windows applications, from the Windows Start menu.

When you access the printer software from a Windows application, the settings that you make apply only to the application you are using.

When you access the printer software from the Start menu, the settings that you make apply to all of your Windows applications.

Refer to the appropriate section below.

From Windows applications

Follow the steps below to access the printer software.

1. From the File menu, click Print or Print Setup.

2. In the dialog box that appears, click Printer, Setup, Options, or Properties. (Depending on your application, you may need to click a combination of these buttons.) The printer driver opens.

From the Start menu

Follow the steps below to access the printer software.

1. Click Start, point to Settings, then click Printers.

2. For Windows Me, 98 and 95 users, select your printer, then click Properties on the File menu.

   For Windows 2000 users, select your printer, then click Printing Preferences on the File menu.

   For Windows NT 4.0 users, select your printer, then click Document Defaults on the File menu.

   The printer driver opens.
Making Changes to Printer Settings

The printer driver features the following menus and settings.

Main: Media Type, Ink, Mode, Print Preview

Paper: Paper Size, Copies, Orientation, Printable Area

Layout: Reduce/Enlarge, Multi-Page, Watermark

The Mode settings on the Main menu provide various setting options, as explained below.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>This mode provides the quickest and easiest way to start printing. See “Using the Automatic mode” on page 2-7.</td>
</tr>
<tr>
<td>PhotoEnhance</td>
<td>This mode lets you choose from a variety of image-correction settings specially designed for photos. See “Using the PhotoEnhance mode” on page 2-8.</td>
</tr>
<tr>
<td>Custom</td>
<td>This mode lets you choose from a list of ready-made or personalized settings suited to the kind of document you want to print. When Custom is selected, the Advanced button is enabled, allowing you to access the Advanced dialog box. See “Using the Custom mode” on page 2-9.</td>
</tr>
</tbody>
</table>

In addition to making comprehensive Mode settings that affect overall print quality, you can also modify individual aspects of your printout using the Paper and Layout menus. See “Modifying the printout style” on page 2-17 for details.
Making the Media Type setting

The Media Type setting determines what other settings are available, so you should always make this setting first.

On the Main menu, select the Media Type setting that matches the media that is loaded in the printer. To find out what Media Type you are using, find your media in the list below, and refer to the corresponding Media Type under which it is grouped (shown in larger type). For some media, there are several Media Type settings to choose from.

Note:
For the latest information on the available media, visit our regional customer service web site. See “Regional Customer Services” on page B-1 for details.
Plain Paper

Plain paper
Envelopes
EPSON Premium Ink Jet Plain Paper (A4) S041214

360 dpi Ink Jet Paper

EPSON 360 dpi Ink Jet Paper (A4) S041059
EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper (A4) S041061
EPSON Photo Quality Ink Jet Cards (A6) S041054
EPSON Photo Quality Ink Jet Cards (5 × 8") S041121
EPSON Photo Quality Ink Jet Cards (8 × 10") S041122
EPSON Photo Quality Self Adhesive Sheets (A4) S041106
EPSON Ink Jet Note Cards A6 (with envelopes) S041147
EPSON Ink Jet Greeting Cards 5 × 8” (with envelopes) S041148
EPSON Ink Jet Greeting Cards 8 × 10” (with envelopes) S041149

Matte Paper-Heavyweight

EPSON Matte Paper-Heavyweight (A4) S041259
## Photo Paper

- EPSON Photo Paper (A4) S041140
- EPSON Photo Paper (4 × 6”) S041134
- EPSON Panoramic Photo Paper (210 × 594 mm) S041145
- EPSON Photo Paper Cards (A4) S041177

## Photo Quality Glossy Film

- EPSON Photo Quality Glossy Film (A4) S041071
- EPSON Photo Quality Glossy Film (A6) S041107
- EPSON Photo Stickers 16 (A6) S041144
- EPSON Photo Stickers 4 (A6) S041176

## Ink Jet Transparencies

- EPSON Ink Jet Transparencies (A4) S041063

## Premium Glossy Photo Paper

- EPSON Premium Glossy Photo Paper (A4) S041287 S041297

### Note:
The availability of special media varies by location.
Using the Automatic mode

When Automatic is selected as the Mode setting on the Main menu, the printer driver takes care of all detailed settings based on the current Media Type and Ink settings. To make the Ink setting, click Color to print in color, or Black to print in black-and-white or grayscale. To make the Media Type setting, see “Making the Media Type setting” on page 2-4.

![Printer driver settings](image)

**Note:**
- Depending on the media selected in the Media Type list (while Automatic is selected), a slider appears under the Custom radio button that lets you choose from Quality or Speed settings. Select Quality when print quality is more important than speed.
- Most Windows applications feature paper size and page layout settings that override similar settings in the printer driver. However, if your application does not have these settings, verify the settings on the printer driver’s Paper menu.
Using the PhotoEnhance mode

The PhotoEnhance mode provides a variety of image-correction settings that you can apply to your photo images before printing. PhotoEnhance does not affect your original data.

Note:
- This mode is only available when printing 8-, 16-, 24-, or 32-bit color data.
- Printing with PhotoEnhance selected may increase the time required for printing, depending on your computer system and the amount of data contained in your image.

You can select from the following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>This setting provides standard image correction for most photos. Try this first.</td>
</tr>
<tr>
<td>People</td>
<td>This setting is best for photos of people.</td>
</tr>
<tr>
<td>Nature</td>
<td>This setting is best for outdoor scenery such as mountains, sky, and oceans.</td>
</tr>
</tbody>
</table>
Selecting PhotoEnhance also enables the Digital Camera Correction check box. Select this check box when you are printing photos taken with a digital camera to give your printed images the smooth, natural appearance of photographs taken with a film camera.

### Using the Custom mode

The Custom mode offers ready-made settings designed for printing text and graphs and for applying a color-matching method. You can also create and save your own custom settings. For details on making your own custom settings, see “Making the Advanced settings” on page 2-10.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soft Focus</td>
<td>This setting makes your photos look as if they were taken with a soft-focus lens.</td>
</tr>
<tr>
<td>Sepia</td>
<td>This setting applies a sepia tone to your photos.</td>
</tr>
</tbody>
</table>
You can select from the following ready-made settings and color-matching methods:

<table>
<thead>
<tr>
<th>Economy</th>
<th>This setting is best for printing drafts of text.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICM</td>
<td>This method automatically adjusts printout colors to match colors on your screen. ICM stands for Image Color Matching.</td>
</tr>
<tr>
<td>sRGB</td>
<td>This method is best for color matching with other sRGB devices.</td>
</tr>
</tbody>
</table>

When you select a Custom setting, other settings such as Print Quality, Halftoning, and Color Adjustment are made automatically. Changes to these settings are reflected in the display on the left side of the Main menu.

Follow the steps below to select a Custom setting.

1. Select Custom as the Mode setting on the Main menu.
2. Click anywhere in the list box to open it, then select the most appropriate setting for the type of document or image that you wish to print.
3. Verify the Media Type and Ink settings before printing, as they may be affected by the Custom setting that you select. See “Making the Media Type setting” on page 2-4 for details.

**Making the Advanced settings**

The settings in the Advanced dialog box give you complete control over your printing environment. Use these settings to experiment with new printing ideas or to fine-tune a range of print settings to meet your individual needs. Once you are satisfied with your new settings, you can give them a name and add them to the Custom Settings list on the Main menu.

Follow the instructions in this section to make Advanced settings.
Note:
The printer driver screens that appear in this procedure are for Windows Me, 98 and 95. The Windows 2000 and NT 4.0 printer driver screens differ slightly in appearance.

1. Select Custom as the Mode setting on the Main menu and then click Advanced. The following dialog box appears.

2. Select the Media Type that is loaded in the printer. For details, see “Making the Media Type setting” on page 2-4.

3. Choose Color or Black as the Ink setting.

4. Specify a Print Quality setting.

5. Make other settings as necessary. For details, see online help.
Note:

- The PhotoEnhance option under Color Management only affects images, not text or graphs. For example, if Monochrome is selected from the Tone list (enabled when PhotoEnhance is selected), only the images in a document will be printed in monochrome. Any colored text or graphs in the same document will be printed in color.

- Some settings may be unavailable, depending on the Media Type, Ink, and Print Quality settings that you make.

6. Click OK to apply your settings and return to the Main menu. If you want to return to the Main menu without applying your settings, click Cancel. To save your Advanced settings, proceed to the next section.

**Saving and deleting your settings**

To save your Advanced settings in the Custom Settings list, click Save Settings in the Advanced dialog box. The Custom Settings dialog box appears.
Type a unique name for your settings in the Name text box, then click Save. Your Advanced settings will be added to the Custom Settings list.

**Note:**
- You cannot apply the names of EPSON ready-made settings to your custom settings.
- You cannot delete the ready-made settings from the Custom Settings list.

To delete a setting from the Custom Settings list, select it in the Custom Settings dialog box and click Delete.

**Using your saved settings**

To use your saved settings, select Custom as the Mode setting on the Main menu, then select your settings in the Custom Settings list, located to the right of the Custom radio button.

If you change the Media Type or Ink settings while one of your customized settings is selected in the Custom Settings list, the selection shown in the list returns to Custom Settings. The customized setting that was previously selected is not affected by the change. To return to your customized setting, simply reselect it in the list.
Previewing your printout

Select the Print Preview check box on the Main menu when you wish to view a preview of your document before printing.
When you send a print job to the printer, the Print Preview window opens, allowing you to make changes before printing.

The Preview dialog box contains several icon buttons which you can use to perform the following functions.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Selection" /></td>
<td>Click this button to select and move watermarks.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Zoom" /></td>
<td>Click this button to enlarge or reduce the size of the previewed page.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Fit-to-screen" /></td>
<td>Click this button to scale the previewed page so that it fits the size of the window. This is convenient when you want to see the entire page at one time.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Maximum zoom" /></td>
<td>Click this button to display the previewed page at the maximum possible zoom ratio.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Printable area on/off" /></td>
<td>Click this button to display a rectangle on the page being previewed. This rectangle is the printable area for the page. The printer cannot print anything which is outside of this rectangle. Click the button again to turn this feature off.</td>
<td></td>
</tr>
</tbody>
</table>
You can also manipulate the previewed document in the following ways:

- Select and preview individual pages.
- Reduce or enlarge the size of the preview.
- Select and print any or all pages.
- Magnify the previewed document. To do this, click View and then Magnify to open the Magnify window, which magnifies the area of the previewed document that is outlined by the red box. By dragging the red box, you can change which part of the document is magnified.
- View the individual pages that comprise a poster. The Poster window opens automatically when you send a print job while Poster is selected as the Multi-Page option on the Layout menu. From this window, you can view the individual pages which make up a poster. You can also open this dialog box by clicking View and then Poster.
Apply watermarks. The watermark that you select will be displayed on the previewed image. For detailed information on customizing watermarks, see “Printing a watermark on your document” on page 2-27.

Specify which pages in the document you would like to print using the Add and Remove features. To add or remove a page, click the page icon in the list at the left side of the preview window. Then, add or remove it using the commands on the Print Options menu. The Print Options menu commands are as follows.

<table>
<thead>
<tr>
<th>Add page</th>
<th>Click this button to add the highlighted pages to the list of pages to be printed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove page</td>
<td>Click this button to remove the highlighted pages from the list of pages to be printed.</td>
</tr>
</tbody>
</table>

After you have previewed the document, click Print to print the document, or click Cancel to cancel printing.

**Modifying the printout style**

You can modify your printout style using a variety of printer driver settings located on the Paper and Layout menus.

On the Paper menu, you can set the paper size, the number of copies, the orientation of your printout, and the printable area. On the Layout menu, you can automatically match the document size to the paper size, print two or four pages on a single sheet of paper, print poster-size images by enlarging one page to cover several sheets, or place watermarks on documents.
Making the Paper menu settings

Use the settings on the Paper menu to change the paper size, set the number of copies and other copy parameters, specify the paper orientation, and adjust the printable area.

You can make the following settings on the Paper menu:

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Select the paper size you want to use. You can also add a custom paper size.</th>
</tr>
</thead>
</table>

[Diagram of Paper menu settings]
| **No Margin** | Check this box when you want to print with no margins.  
This feature prints to all four edges of the paper.  
You can use the following media with this feature.  
Photo Paper:  
Panoramic, A4, Letter, 4 × 6\(^*\) (No Perforations), 100 × 150 mm  
Matte Paper-Heavyweight:  
A4, Letter  
Index Card:  
5 × 8\(^*\)  
**Note:**  
If your application has margin settings, make sure they are set to zero before printing.  
Printing with this feature selected takes longer than for normal printing.  
Because this feature enlarges the image to a size slightly larger than the paper size when Sheet Feeder is selected as the Paper Source setting, the portion of the image that extends beyond the edges of the paper will not be printed.  
Print quality may decline in the top and bottom areas of the printout, or the area may be smeared when printing on media other than that listed above.  
We recommend printing a single sheet to check quality before printing large jobs.  
You cannot use this feature with Photo Quality Glossy Film, Ink Jet Transparencies, Iron-On Cool Peel Transfer Paper or 360 dpi Ink Jet Paper. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copies</strong></td>
<td>Select the number of copies you wish to print. You can select Collate to print one set at a time or Reverse Order to determine the order in which you wish to print multiple copies of your document.</td>
</tr>
<tr>
<td><strong>Orientation</strong></td>
<td>Select Portrait (tall) or Landscape (wide) to change the orientation of your printout. If you need to print closer to the bottom of the page, select the Rotate by 180° check box.</td>
</tr>
</tbody>
</table>
Fitting your document to the paper size

Use the Reduce/Enlarge options on the Layout menu to fit your document to the paper size you will print on.

### Printable Area

<table>
<thead>
<tr>
<th><strong>Printable Area</strong></th>
<th>Use the options in the Printable Area box to adjust the total area available for printing.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>To center the printout, select Center. To increase the printable area at the bottom edge from 14 mm to 3 mm, select Maximum. Do not select Maximum while using Premium Glossy Photo Paper.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The print quality may decline at the edges of the printout when Maximum is selected as the Printable Area setting. Before printing large jobs using this setting, print a single sheet to confirm quality. When Maximum is selected, make sure that the paper loaded in the sheet feeder is not curled.</td>
</tr>
</tbody>
</table>

You can select from the following settings.

| **Normal** | Prints your document at its normal size. |

2-20 Printing with Windows
Printing two or four pages on one sheet

Select N-up as the Multi-Page setting on the Layout menu to print two or four pages of your document on one sheet of paper.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit to Page</td>
<td>Proportionally enlarges or reduces the size of your document to make it fit the paper size you select in the Paper Size list on the Paper menu.</td>
</tr>
<tr>
<td>Custom</td>
<td>Allows you to manually reduce or enlarge an image. Click the arrows next to the Scale to box to select a percentage between 10% and 400%.</td>
</tr>
</tbody>
</table>

To print more than one page on a piece of paper, you should make the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Pages</td>
<td>Prints two or four pages of your document on a single piece of paper.</td>
</tr>
<tr>
<td>4 Pages</td>
<td></td>
</tr>
<tr>
<td><strong>Page Order</strong></td>
<td>Opens the Print Layout dialog box, where you can specify the order in which the pages will be printed on the sheet of paper. Some settings may be unavailable, depending upon your Orientation selection on the Paper menu.</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Print page frames</strong></td>
<td>Prints a frame around each page that is printed on the sheet of paper.</td>
</tr>
</tbody>
</table>

**Printing posters**

A single document page can be enlarged to cover 4, 9, or 16 printed sheets of paper. Select **Poster** as the Multi-Page setting to print a poster-size image.
Click the Settings button to adjust the way your poster will print. The Poster Settings dialog box opens.

![Poster Settings dialog box](image)

You can make the following settings

<table>
<thead>
<tr>
<th>Print Cutting Guides</th>
<th>Check this box to turn the cutting guide options on.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overlapping Alignment Marks</td>
<td>Slightly overlaps the images and prints alignment markers so that they can be aligned more precisely.</td>
</tr>
<tr>
<td>Trim Lines</td>
<td>Prints border lines on the images to guide you when trimming the pages.</td>
</tr>
</tbody>
</table>

If you only want to print a few of the panels without printing the entire poster, click the panels that you do not wish to print, then click OK to close the Poster Settings dialog box.
How to make a poster from your printouts

Here is an example of how to make a poster from 4 sheets of your printout. Refer to the accompanying illustrations as well.

1. Vertically cut the margin of Sheet 1 along the line connecting the alignment markers as shown in the illustration.
2. Place Sheet 1 on Sheet 2 and align the cross markers on both sheets, then temporary tape them from the back side of the paper.

![Diagram of Sheet 1 and Sheet 2 aligned and taped]

3. Cut off the taped sheets along the line between the alignment markers.

![Diagram showing cut off tape and separated sheets]

4. Align the paper using the alignment markers and tape them from the back side of the paper.

![Diagram of aligned and taped sheets]

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 and 4 as well.
6. Repeat the instructions from step 1 to step 4 to tape top and bottom faces of the paper.

7. Cut off the remaining margins.

**Caution:**

Be careful when using edged tools.

If you only want to print a few of the panels without printing the entire poster, click the panels you don’t wish to print, then click OK to close the Poster Settings dialog box.
Printing a watermark on your document

To print a watermark on your document, click anywhere in the Watermark list box on the Layout menu, and select from the list of predefined watermarks that appears.
You can also add your own text-based or image-based watermarks to the Watermark list. To add a watermark, click the Add/Del button. The following dialog box appears.

Refer to the appropriate section below to finish creating a custom watermark.

**Creating an image-based watermark**

Follow the steps below to create an image-based watermark.

1. Select BMP.

2. Click the *Browse* button to specify the bitmap file you want to use, then click *OK*.

3. Type a name for your watermark in the Name box, then click *Save*. Click OK to return to the Layout menu.
Creating a text-based watermark

Follow the steps below to create a text-based watermark.

1. Select Text.

2. Type your text in the Text box. The text that you enter will also be assigned to the watermark as a watermark name.

3. If you want to change the watermark name, type a new name in the Name box, then click Save. Click OK to return to the Layout menu.

Making settings for your watermark

Follow the steps below to make settings for your watermark.

1. Select the desired Watermark in the Watermark list box on the Layout menu.

2. Click the Settings button. The following dialog box appears.
3. Make sure that the appropriate watermark is selected in the Watermark list box, then make Color, Position, Density, Size, Font, Font Style, and Angle settings. For details, please see online help. Your settings are reflected in the display at the left side of the dialog box.

4. When you are finished making settings, click OK.

---

**Using the Printer Utilities**

EPSON printer utilities allow you to check the current printer status and to perform some printer maintenance from your computer.

To use the utilities, click the Utility tab in the printer software window, then click the button for the utility you wish to use. For information on how to access the printer software, see “Accessing the printer software” on page 2-2.
Note:

- The letter in parentheses after the utility name indicates the shortcut key for that utility. Press Alt and the letter on the keyboard to open that utility.

- Do not use the Nozzle Check, Head Cleaning, or Print Head Alignment utilities if your printer is connected to your computer through a network.

- Do not use the Nozzle Check, Head Cleaning, Print Head Alignment, or Ink Cartridge Replacement utilities while printing is in progress; otherwise, your printout may be marred.

**Status Monitor 3**

Status Monitor 3 provides you with printer status information, such as the amount of ink remaining, and checks for printer errors.

This utility is only available when both of the following conditions are met:

- The printer is connected directly to the host computer via the parallel or USB port.
- Your system is configured to support bidirectional communication.

**Nozzle Check**

The Nozzle Check utility checks the print head nozzles for clogging. Check the nozzles if you notice print quality has declined and after cleaning to confirm that the print head nozzles have been cleared. If the nozzle check indicates the print head needs cleaning, you can access the Head Cleaning utility directly from the Nozzle Check utility. See “Checking the Print Head Nozzles” on page 8-1.
**Head Cleaning**

The Head Cleaning utility cleans the print head. You may need to clean the print head when you notice print quality has declined. Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. You can access the Nozzle Check utility directly from the Head Cleaning utility. See “Cleaning the Print Head” on page 8-3.

**Print Head Alignment**

The Print Head Alignment utility aligns the print head. Use this utility if you notice a misalignment of vertical lines. Follow the on-screen instructions to use this utility.

**Printer and Option Information**

This utility allows the printer driver to confirm printer configuration information. It also provides specific information regarding certain characteristics of the printer, such as the Printer ID.
Depending on the configuration of your system, the information displayed in the Printer and Option Information dialog box may be updated automatically, or may need to be entered manually.

If a message appears in the Current Settings window prompting you to enter settings, or if you change the printer configuration, follow the steps below to make the necessary settings manually.

1. Click the Settings Sheet button in the Printer and Option Information dialog box to print out information about your printer and options. This requires that A4 or Letter size paper is loaded in your printer. You will see a printout similar to the one below.

   \[
   \text{Printer ID} \\
   50 - 50 - 50 - 50 - 50 - 50
   \]

2. Make sure the settings in the utility match the information on the printed Settings Sheet. If they do not match, correct the settings on the screen to match the information on the settings sheet.

3. Click OK to exit this menu and save your settings.
**Speed & Progress**

You can make settings related to print speed and progress in this dialog box.

![Speed & Progress dialog box](image)

The available settings are as follows:

**High Speed Copies**

To print multiple copies of your document faster, select High Speed Copies.

**EPSON Printer Port (for Windows Me, 98 and 95 only)**

To speed up the data transfer rate to EPSON printers, select EPSON Printer Port.

If your computer supports ECP mode, enable DMA transfer to speed up printing.

For more details, see “Using Speed & Progress” on page 2-40.
Always Spool Raw Datatype (for Windows 2000 and NT 4.0 only)

Select this check box to have Windows NT-based clients spool documents using the RAW format instead of the EMF (metafile) format (Windows NT-based applications use the EMF format by default).

Try using this option if documents spooled in EMF format do not print correctly.

Spooling RAW datatype requires less resources than EMF, so some problems (“Insufficient Memory/Disk Space to Print”, “Slow print speed”, etc.) can be solved by selecting the “Always spool RAW datatype” check box.

When spooling RAW datatype, print progress as displayed by the Progress Meter may differ from actual print progress.

Monitoring Preferences

Click this button to open the Monitoring Preferences dialog box where you can make settings for EPSON Status Monitor 3. These settings are described in detail in the next section.
**Monitoring Preferences**

When you click the Monitoring Preferences button, the following dialog box appears.

![Monitoring Preferences Dialog Box]

You can make the following settings:

<table>
<thead>
<tr>
<th>Select Notification</th>
<th>Displays the current error item notification settings. In this area, you can designate whether to have general error messages, communication error messages, or ink status messages displayed during printing or copying. Select the appropriate check box to specify the error types for which you wish to receive notification. Also select the Alert check box if you wish to be notified of error messages with an audio alert.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Shortcut Icon</td>
<td>Select this check box to have a shortcut icon placed in your Windows taskbar. Click the shortcut icon in the taskbar to open EPSON Status Monitor 3. Right-click the icon to display a shortcut menu, from which you can access some of the printer utilities. To select which icon will be displayed, click the icon you prefer from the choices given; your selection will be displayed at the right.</td>
</tr>
</tbody>
</table>
Allow monitoring of shared printers | Select this check box to allow monitoring of a shared printer by other computers.

Note:
Click the Default button to revert all Select Notification settings to their defaults.

Getting Information Through Online Help

Your printer software has an extensive online help feature, which provides you with instructions on printing, making printer driver settings, and using printer utilities.

Refer to the appropriate section below.

Accessing help from your application

Open the File menu and choose Print or Print Setup. Then, click Printer, Setup, Options, or Properties. (Depending on your application, you may need to click a combination of these buttons.) Click Help at the bottom of the Main, Paper, Layout, or Utility menu for help related to the items on that menu.

For Windows users, you can get specific help related to any item on a menu by right-clicking the item and then clicking the What’s This? command.

Accessing help from the Windows Start menu

Click the Start button, point to Programs and Epson (for Windows Me, 98 and 95) or EPSON Printers (for Windows 2000 and NT 4.0), then click EPSON Stylus PHOTO 790 Help. The help contents window opens.
**Increasing the Print Speed**

Follow the instructions in this section to increase the printing speed of your printer.

**General tips**

Just as printing at a high resolution requires more processing time than printing at a low resolution, printing in color takes longer than printing in black-and-white because the volume of data in a color document is much greater. For this reason, it is important to be selective in your use of color if you also require a fast print speed.

However, even if your document requires the highest resolution and extensive use of color—for example, when you are printing a camera-ready composite that includes color photographs—it may still be possible to optimize the print speed by adjusting other printing conditions. Keep in mind that changing some conditions to increase the print speed may also lower print quality.

The following table shows the factors that inversely affect print speed and print quality (increasing one will decrease the other).

<table>
<thead>
<tr>
<th>Print quality / Print speed</th>
<th>Lower Faster</th>
<th>Higher Slower</th>
<th>Printer driver menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer driver settings</strong></td>
<td>Print Quality</td>
<td>Economy, Normal</td>
<td>Photo</td>
</tr>
<tr>
<td>High Speed</td>
<td>On</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Finest Detail</td>
<td>Off</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td><strong>Data characteristics</strong></td>
<td>Image size</td>
<td>Small</td>
<td>Large</td>
</tr>
<tr>
<td>Resolution</td>
<td>Low</td>
<td>High</td>
<td></td>
</tr>
</tbody>
</table>
The table below shows the factors related to print speed only.

<table>
<thead>
<tr>
<th>Print speed</th>
<th>Faster</th>
<th>Slower</th>
<th>Printer driver menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer driver settings</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ink</td>
<td>Black</td>
<td>Color</td>
<td>Advanced dialog box, Main menu</td>
</tr>
<tr>
<td>Flip Horizontal*</td>
<td>Off</td>
<td>On</td>
<td>Advanced dialog box</td>
</tr>
<tr>
<td>Collate*</td>
<td>Off</td>
<td>On</td>
<td>Paper menu</td>
</tr>
<tr>
<td>Reverse Order*</td>
<td>Off</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td><strong>Data characteristics</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variety of colors</td>
<td>Grayscale**</td>
<td>Full color</td>
<td>–</td>
</tr>
<tr>
<td><strong>Hardware resources</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System speed</td>
<td>Faster</td>
<td>Slower</td>
<td>–</td>
</tr>
<tr>
<td>HDD free space</td>
<td>Large</td>
<td>Small</td>
<td></td>
</tr>
<tr>
<td>Memory free space</td>
<td>Large</td>
<td>Small</td>
<td></td>
</tr>
<tr>
<td><strong>Software status</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Running applications</td>
<td>One</td>
<td>Many</td>
<td>–</td>
</tr>
<tr>
<td>Virtual memory</td>
<td>Not in use</td>
<td>In use</td>
<td></td>
</tr>
</tbody>
</table>

* Varies depending on the printer driver and application that you are using.

** Grayscale means using black ink only to print varying shades of gray, from pure black to pure white.
Using Speed & Progress

You can make certain print speed settings in the Speed & Progress dialog box. Click the Speed & Progress button on your printer software’s Utility menu. The following dialog box appears.

The available settings are as follows:

**High Speed Copies**

Select this check box to turn on high-speed printing for multiple copies. This speeds up printing by using your hard disk space as a cache when printing multiple copies of your document.

**EPSON Printer Port (For Windows Me, 98 and 95 only)**

Select this check box to enable the EPSON printer port, which is optimized for EPSON printers, instead of the Windows default printer port. This speeds up the data transfer rate to EPSON printers.
Use DMA transfer (For Windows Me, 98 and 95 only)

If your computer has a parallel port which supports ECP mode, you can enable DMA transfer to speed up printing. See your computer manual to determine if it supports ECP mode and DMA transfer.

To determine whether you need to enable DMA transfer, compare the message below the EPSON Printer Port check box to this table, and take the recommended action.

<table>
<thead>
<tr>
<th>Message</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Speed (DMA) Transfer enabled.</td>
<td>DMA transfer is already enabled. Click OK to close the dialog box.</td>
</tr>
<tr>
<td>For higher data transfer rates, use DMA Transfer.</td>
<td>Follow the steps below this table to enable DMA transfer.</td>
</tr>
<tr>
<td>(No message)</td>
<td>Your system's parallel port setting does not allow DMA transfer. However, if you change the parallel port setting to ECP or Enhanced using your computer's BIOS Setup program, you may be able to use DMA transfer. Consult your computer manual or computer manufacturer for instructions. Once you change the parallel port setting, follow the steps below this table to enable DMA transfer.</td>
</tr>
</tbody>
</table>

**Note:**
Before you run the BIOS Setup program, uninstall the printer driver using Add/Remove Programs in the Control Panel. After running the BIOS Setup program, reinstall the printer driver.

If you need to enable DMA transfer, follow the steps below.

1. Double-click the My Computer icon on your desktop, then double-click Control Panel.

2. Double-click the System icon and click the Device Manager tab.
3. Double-click the Ports (COM & LPT) icon and then the LPT1 icon. If you have connected your printer to a port other than LPT1, double-click the appropriate port icon.

4. Click the Resources tab, then clear the Use automatic settings check box. Write down the Input/Output Range settings shown in the resource settings box.

5. Select a basic configuration setting from the Setting based on list that uses the same Input/Output Range settings as those you wrote down in Step 4, and make sure the Direct Memory Access channel and Interrupt Request numbers are allocated and displayed. Confirm also that the Conflicting device box shows No conflicts.

6. Click OK to save the settings.

7. Reopen the Speed & Progress dialog box to verify whether DMA transfer has been enabled.
Note:
You may not be able to use DMA transfer on some computers even after you make the settings explained above. Consult your computer maker for information on the DMA transfer capability of your computer.

**Using Port Configuration (Windows NT 4.0 only)**

Note:
Port settings are complicated and should only be made by an experienced user with administrative privileges.

If your computer has a parallel port that supports ECP mode, you can make certain print speed settings in the Port Configuration dialog box. Before making settings, make sure that ECP mode has been selected in your computer settings. For details about ECP mode, see your computer manual.

To access the Port Configuration dialog box, click the Start button, point to Settings, and click Printers. Then, select your printer and click Properties on the File menu. The printer driver opens. Click the Ports tab, then click Configure Port. The following dialog box appears.
Click the LPT port tab for the port to which your printer is connected, then click the Port Configuration button.

**Note:**  
*If your printer is connected to LPT1, only the LPT1 tab is available.*

The available settings are as follows:

**Resource settings (IRQ and DMA)**

If you have connected your printer to LPT2 or LPT3, making IRQ and DMA settings here may speed up printing. Click Change setting and input the same configuration numbers for IRQ and DMA which you have made with your expansion board. See your computer documentation to determine the settings for IRQ and DMA.

**Use DMA transfer**

Using DMA transfer to send print data to the computer may help speed up printing. If the Use DMA Transfer check box is not enabled, you must first enable DMA transfer in your computer settings. For details, see your computer documentation.
Chapter 3
Checking Printer Status and Managing Print Jobs for Windows

Using the Progress Meter

When you send a print job to the printer, the Progress Meter opens, as shown in the illustration below.

The Progress Meter indicates the progress of the current print job and provides printer status information when bidirectional communication between the printer and computer is established. This meter also displays helpful tips for better printing and error messages, as explained below.
Epson Printing Tips

Tips for getting the most out of your EPSON printer driver appear in the text box at the bottom of the Progress Meter window. A new tip appears every 30 seconds. For more details on a tip which is currently displayed, click the Details button.

Error messages

If a problem occurs during printing, an error message appears in the text box at the top of the Progress Meter window. For more detailed information, click Technical Support to refer to the Problem Solver or access to the Technical Support web site for help.

When the ink runs low or out, a How To button appears below the text box. Click How To and EPSON Status Monitor 3 will lead you step-by-step through the cartridge replacement procedure.

Note:
Depending on your location, the Problem Solver may not be accessible.
Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If it receives two or more print jobs at one time, it holds them in the order that they were received (with printers on a network this may be called a print queue). When a print job reaches the top of the line, the EPSON Spool Manager sends the job to the printer. From the Spool Manager, you can view print status information about the print jobs which have been sent to your printer. You can also cancel, pause and resume, or restart selected print jobs.

Note:
EPSON Spool Manager is not available for Windows 2000 or Windows NT.

For Windows Me, 98 and 95

After you send a print job, an EPSON Stylus PHOTO 790 button appears on the taskbar. Click this button to open the EPSON Spool Manager.

Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed information on the printer status.
Note:
Before using EPSON Status Monitor 3, be sure to read its README file. To open this file, click Start, point to Programs and then EPSON or EPSON Printers, then click EPSON Stylus PHOTO 790 Readme.

**Accessing EPSON Status Monitor 3**

There are two ways to access EPSON Status Monitor 3:

- Double-click the printer-shaped shortcut icon on the Windows taskbar. See “Monitoring Preferences” on page 2-36.

- Open the printer driver, click the Utility tab, then click EPSON Status Monitor 3.

When you access EPSON Status Monitor 3, the following window appears.

![EPSON Status Monitor 3 Window](image)

**Viewing information in EPSON Status Monitor 3**

EPSON Status Monitor 3 provides the following information.
Current Status:
EPSON Status Monitor 3 provides you with detailed printer status information, a graphic display, and status messages. If the ink runs low or out, the **How to** button appears in the EPSON Status Monitor 3 window. Clicking **How to** displays ink cartridge replacement instructions and moves the print head to the ink cartridge replacement position.

Ink Levels:
EPSON Status Monitor 3 provides a graphic display of the amount of ink remaining. For the color ink cartridge, the chamber with the least amount of ink remaining determines the level that is displayed for all of the colors in the cartridge.

**Note:**
*EPSON Status Monitor 3 provides an estimate of the number of pages that can be printed based on the amount of ink remaining.*

Ink Cartridge Information:
You can view information about the installed ink cartridges by clicking the **Information** icon.

Technical Support
You can access the Problem Solver or the Technical Support Web Site from EPSON Status Monitor 3. If you encounter a problem, click **Technical Support** in the EPSON Status Monitor 3 window.

**Note:**
*Depending on your location, the Problem Solver may not be accessible.*
Chapter 4

Using the Printer Software for Macintosh

Printer Software Introduction

The printer software which comes with your printer includes a printer driver and printer utilities. The printer driver lets you choose from a wide variety of settings to get the best results from your printer. The printer utilities help you check the printer and keep it in top condition.

For information on using the printer driver, see “Making Changes to Printer Settings” on page 4-1.

For information on using the printer utilities, see “Using the Printer Utilities” on page 4-28.

You can also get more information about the printer software by clicking the help icon in any of the dialog boxes in the printer driver.

Making Changes to Printer Settings

You will find the printer driver settings in the following dialog boxes.

- Print dialog box (click Print on the File menu of your application or click Options in the Page Setup dialog box)
- Page Setup dialog box (click Page Setup on the File menu of your application)
- Layout dialog box (click the Layout icon button in the Print dialog box)
❏ Background Printing dialog box (click the Background Printing icon button located in the Print dialog box)

❏ Preview dialog box (click the Preview icon button and then click Preview in the Print dialog box)

The Mode settings in the Print dialog box provide various setting options, as explained below.

The Mode settings are explained below:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>This mode provides the quickest and easiest way to start printing. See “Using the Automatic mode” on page 4-6.</td>
</tr>
<tr>
<td>PhotoEnhance</td>
<td>This mode lets you choose from a variety of image-correction settings specially designed for photos. See “Using the PhotoEnhance mode” on page 4-6.</td>
</tr>
<tr>
<td>Custom</td>
<td>This mode lets you choose from a list of ready-made or personalized settings suited to the kind of document that you want to print. When Custom is selected, the Advanced button is enabled, allowing you to access the Advanced dialog box. See “Using the Custom mode” on page 4-8.</td>
</tr>
</tbody>
</table>

In addition to making comprehensive Mode settings that affect overall print quality, you can also modify individual aspects of your printout using the settings contained in the Page Setup and the Layout dialog boxes. For information on page setup options, see “Changing the page setup” on page 4-11. For information on page layout options, see “Modifying the page layout” on page 4-15.

**Making the Media Type setting**

The Media Type setting determines what other settings are available, so you should always make this setting first.
In the Print dialog box, select the Media Type setting that matches the paper you loaded in the printer. To find out what media type you are using, find your media in the list below, and refer to the corresponding media type under which it is grouped (shown in larger type). For some media, there are several Media Type settings to choose from.

**Note:**
For the latest information on the available media, visit our regional customer service web site. See “Regional Customer Services” on page B-1 for details.
Plain Paper

Plain paper
Envelopes
EPSON Premium Ink Jet Plain Paper (A4) S041214

360 dpi Ink Jet Paper

EPSON 360 dpi Ink Jet Paper (A4) S041059
EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper (A4) S041061
EPSON Photo Quality Ink Jet Cards (A6) S041054
EPSON Photo Quality Ink Jet Cards (5 × 8”) S041121
EPSON Photo Quality Ink Jet Cards (8 × 10”) S041122
EPSON Photo Quality Self Adhesive Sheets (A4) S041106
EPSON Ink Jet Note Cards A6 (with envelopes) S041147
EPSON Ink Jet Greeting Cards 5 × 8” S041148
(with envelopes)
EPSON Ink Jet Greeting Cards 8 × 10” S041149
(with envelopes)

Matte Paper-Heavyweight

EPSON Matte Paper-Heavyweight (A4) S041259
**Photo Paper**

<table>
<thead>
<tr>
<th>Product Description</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Photo Paper (A4)</td>
<td>S041140</td>
</tr>
<tr>
<td>EPSON Photo Paper (4 × 6”)</td>
<td>S041134</td>
</tr>
<tr>
<td>EPSON Panoramic Photo Paper (210 × 594 mm)</td>
<td>S041145</td>
</tr>
<tr>
<td>EPSON Photo Paper Cards (A4)</td>
<td>S041177</td>
</tr>
</tbody>
</table>

**Photo Quality Glossy Film**

<table>
<thead>
<tr>
<th>Product Description</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Photo Quality Glossy Film (A4)</td>
<td>S041071</td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Film (A6)</td>
<td>S041107</td>
</tr>
<tr>
<td>EPSON Photo Stickers 16 (A6)</td>
<td>S041144</td>
</tr>
<tr>
<td>EPSON Photo Stickers 4 (A6)</td>
<td>S041176</td>
</tr>
</tbody>
</table>

**Ink Jet Transparencies**

<table>
<thead>
<tr>
<th>Product Description</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Ink Jet Transparencies (A4)</td>
<td>S041063</td>
</tr>
</tbody>
</table>

**Premium Glossy Photo Paper**

<table>
<thead>
<tr>
<th>Product Description</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Premium Glossy Photo Paper (A4)</td>
<td>S041287</td>
</tr>
</tbody>
</table>

**Note:**
The availability of special media varies by location.
Using the Automatic mode

When Automatic is selected as the Mode setting in the Print dialog box, the printer driver takes care of all detailed settings based on the current Media Type and Ink settings. To make the Ink setting, click Color to print in color, or Black to print in black-and-white or grayscale. To make the Media Type setting, see “Making the Media Type setting” on page 4-2.

Note:
Depending on the media you choose in the Media Type list (while Automatic is selected), a slider appears to the right of the Mode options that lets you choose Quality or Speed. Select Quality when print quality is more important than speed.

Using the PhotoEnhance mode

The PhotoEnhance mode provides a variety of image-correction settings that you can apply to your photo images before printing. PhotoEnhance does not affect your original data.
Note:
- This mode is only available when printing 32-bit color data.
- Printing with PhotoEnhance selected may increase the time required for printing, depending on your computer system and the amount of data contained in your image.

You can select from the following settings.

<table>
<thead>
<tr>
<th>Standard</th>
<th>This setting provides standard image correction for most photos. Try this first.</th>
</tr>
</thead>
<tbody>
<tr>
<td>People</td>
<td>This setting is best for photos of people.</td>
</tr>
<tr>
<td>Nature</td>
<td>This setting is best for outdoor scenery such as mountains, sky, and oceans.</td>
</tr>
<tr>
<td>Soft Focus</td>
<td>This setting makes your photos look as if they were taken with a soft-focus lens.</td>
</tr>
<tr>
<td>Sepia</td>
<td>This setting applies a sepia tone to your photos.</td>
</tr>
</tbody>
</table>

If you are printing photos taken with a digital camera, you can also select the Digital Camera Correction check box to give your printed images the smooth, natural appearance of photographs taken with a film camera.
Using the Custom mode

The Custom mode offers ready-made settings designed for printing text and graphs and for applying a color-matching method. You can also create and save your own custom settings. For details on making your own custom settings see “Making the Advanced settings” on page 4-9.

You can select from the following ready-made settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Economy</td>
<td>This setting is best for printing drafts of text.</td>
</tr>
<tr>
<td>ColorSync</td>
<td>This setting automatically adjusts printout colors to match colors on your screen.</td>
</tr>
</tbody>
</table>

When you select a Custom setting, other settings such as Print Quality, Halftoning, and Color Management are made automatically. Changes to these settings are reflected in the display at the left side of the Print dialog box.

Follow the steps below to select a Custom setting.

1. Confirm that the Media Type and Ink settings in the Print dialog box are correct. For details, see “Making the Media Type setting” on page 4-2.

2. Select Custom as the Mode setting in the Print dialog box. This enables the Custom Settings list, located to the right of the Custom radio button.
3. From the Custom Settings list, select the most appropriate setting for the type of document or image that you will print.

**Making the Advanced settings**

The settings in the Advanced dialog box give you complete control over your printing environment. Use these settings to experiment with new printing ideas, or to fine-tune a range of print settings to meet your individual needs. Once you are satisfied with your new settings, you can give them a name and add them to the Custom Settings list.

Follow the instructions below to make Advanced settings.

1. Select Custom as the Mode setting in the Print dialog box, then click the Advanced button. The Advanced dialog box opens.

2. Select the Media Type that is loaded in the printer. For details, see “Making the Media Type setting” on page 4-2.

3. Choose Color or Black as the Ink setting.

4. Select the Print Quality setting.

5. Make other settings as necessary. For details, see online help.
Note:

- The PhotoEnhance feature only affects images, not text or graphs. For example, if Monochrome is selected in the Tone list (enabled when PhotoEnhance is selected as the Color Management setting), only the images in a document will be printed in monochrome. Any colored text or graphs in the same document will be printed in color.

- Some settings may be unavailable, depending on the Print Quality, Media Type, and Ink settings that you make.

6. Click OK to apply your settings and return to the Print dialog box. Click Cancel to return to the Print dialog box without applying your settings. To save your Advanced settings, see the next section.

Saving and deleting your settings

To save your Advanced settings in the Custom Settings list, click Save Settings in the Advanced dialog box. The Custom Settings dialog box appears.

Type a unique name (up to 16 characters) for your settings in the Name box, then click Save. Your Advanced settings will be added to the Custom Settings list. You can save up to 10 different custom settings.

Note:

- You cannot apply the names of EPSON ready-made settings to your custom settings.
You cannot delete the ready-made settings from the Custom Settings list.

To delete a setting from the Custom Settings list, select it in the Custom Settings dialog box and click Delete.

**Using your saved settings**

To use your saved settings, select Custom as the Mode setting in the Print dialog box, then select your setting in the Custom Settings list, located to the right of the Custom radio button.

If you change the Media Type or Ink settings while one of your customized settings is selected in the Custom Settings list, the selection shown in the list returns to Custom Settings. The customized setting that was previously selected is not affected by the change. To return to your customized setting, simply reselect it in the list.

**Changing the page setup**

In the Page Setup dialog box, you can change the paper size, specify the paper orientation, reduce or enlarge your printout, and adjust the printable area.

Choose Page Setup from the File menu of your application. The Page Setup dialog box appears.
You can make the following settings in the Page Setup dialog box.

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Select the paper size you want to use. If you want to define a custom paper size, see “Defining a custom paper size” on page 4-13.</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Margin</td>
<td>Check this box when you want to print with no margins. This feature prints to all four edges of the paper. You can use the following media with this feature. Photo Paper: Panoramic, A4, Letter, 4 × 6&quot; (No Perforations), 100 × 150 mm Matte Paper-Heavyweight: A4, Letter Index Card: 5 × 8&quot; Note: If your application has margin settings, make sure they are set to zero before printing. Printing with this feature selected takes longer than for normal printing. Because this feature enlarges the image to a size slightly larger than the paper size when Sheet Feeder is selected as the Paper Source setting, the portion of the image that extends beyond the edges of the paper will not be printed. Print quality may decline in the top and bottom areas of the printout, or the area may be smeared when printing on media other than that listed above. We recommend printing a single sheet to check quality before printing large jobs. You cannot use this feature with Photo Quality Glossy Film, Ink Jet Transparencies, Iron-On Cool Peel Transfer Paper or 360 dpi Ink Jet Paper.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Select Portrait (tall) or Landscape (wide) to change the orientation of your printout. If you need to print close to the bottom of the page, select the Rotate by 180 degrees check box.</td>
</tr>
<tr>
<td>Reduce or Enlarge</td>
<td>Use this setting to reduce or enlarge the size of your image from 25% to 400%.</td>
</tr>
</tbody>
</table>
Defining a custom paper size

If the appropriate paper size is not included in the Paper Size list in the Page Setup dialog box, follow the steps below to define a custom paper size.

1. In the Page Setup dialog box, click Customize. The following dialog box appears.

   ![](image)

   **Printable Area**

   Use the options in the Printable Area box to adjust the total area available for printing.

   To center the printout, select Centered. To increase the printable area at the bottom edge from 14 mm to 3 mm, select Maximum. Do not select Maximum while using Premium Glossy Photo Paper.

   **Note:**

   The print quality may decline at the edges of the printout when Maximum is selected as the Printable Area setting. Before printing large jobs using this setting, print a single sheet to confirm quality. When Maximum is selected, make sure that the paper loaded in the sheet feeder is not curled.
2. To define a new paper size, click **New**. The dialog box updates to allow you to enter a name for the new size.

3. Type a unique name for the paper size in the Paper Size list.
4. Specify the measurement unit as either **inch** or **cm**.
5. Enter the width and the height of your paper.
6. Specify the margins by typing in the Margin input boxes or by manipulating the preview image.
7. Click **OK**. You return to the Page Setup dialog box.

You can define up to 100 paper sizes. The paper size names you create will appear in the Paper Size list in the Page Setup dialog box.

To delete a custom paper size, click **Customize** in the Page Setup dialog box, select the paper size from the list in the Custom Paper dialog box, and click **Delete**.

**Copying a paper size**

Follow the steps below to copy an existing paper size to use as a template.
1. Select the existing paper size to copy and click Copy.

2. Specify the measurement unit as either inch or cm.

3. Specify the margins by typing in the Margin input boxes or by manipulating the preview image.

4. Click OK.

**Modifying the page layout**

You can modify the page layout of your document using the printer driver settings located in the Layout dialog box, shown below. To open this dialog box, click Print on the File menu of your application, then click the Layout icon button in the Print dialog box. The Layout dialog box appears.
The Layout dialog box allows you to automatically match the document size to the paper size, place watermarks on documents, print two or four pages on a single sheet of paper, print poster-size images by enlarging one page to cover several sheets, or set the order in which you would like the pages of your document to print.

You can also specify the printing order for your print job. When printing multiple copies of your document, select Collate to print one complete document set at a time. Select Reverse Order to print your documents in reverse order, starting with the last page.

**Fitting your document to the paper size**

You can proportionally enlarge or reduce the size of the image to make it fit the paper size you select in the Paper Size list. To do this, select the Fit to Page check box, then specify the paper size you loaded in the printer in the Paper Size list.
Printing two or four pages on one sheet

To print two or four pages of your document on one sheet of paper, select the Multi-Page check box in the Page Layout dialog box, then select N-up.

You can make the following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Pages 4 Pages</td>
<td>Prints two or four pages of your document on a single piece of paper.</td>
</tr>
<tr>
<td>Page Order</td>
<td>Allows you to specify the order in which the pages will be printed on the sheet of paper.</td>
</tr>
<tr>
<td>Print page frames</td>
<td>Allows you to print a frame around each page on the sheet of paper.</td>
</tr>
</tbody>
</table>
Printing posters

A single document page can be enlarged to cover 4, 9, or 16 printed sheets of paper. To print a poster-size image, select the Multi-Page check box in the Page Layout dialog box, then select Poster.

![Page Layout dialog box]

You can make the following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 page covers xx sheets</td>
<td>Specifies how many printed sheets of paper the enlarged document page is to cover. You can select 4, 9, or 16 pages.</td>
</tr>
<tr>
<td>Overlapping Alignment Marks</td>
<td>Slightly overlaps the images and prints alignment markers so that they can be aligned more precisely.</td>
</tr>
<tr>
<td>Trim Lines</td>
<td>Prints border lines on the images to guide you when trimming the pages.</td>
</tr>
<tr>
<td>Panel Selection</td>
<td>Click the panels you do not need to print, then click the OK button to print the remaining panels.</td>
</tr>
</tbody>
</table>
How to make a poster from your printouts

Here is an example of how to make a poster from 4 sheets of your printout. Refer to the accompanying illustrations as well.

1. Vertically cut the margin of Sheet 1 along the line connecting the alignment markers as shown in the illustration.
2. Place Sheet 1 on Sheet 2 and align the cross markers on both sheets, then temporary tape them from the back side of the paper.

![Diagram of Sheets 1 and 2 aligned]

3. Cut off the taped sheets along the line between the alignment markers.

![Diagram showing sheets cut along alignment markers]

4. Align the paper using the alignment markers and tape them from the back side of the paper.

![Diagram of sheets aligned and taped]

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 and 4 as well.
6. Repeat the instructions from step 1 to step 4 to tape top and bottom faces of the paper.

7. Cut off the remaining margins.

⚠️ **Caution:**
*Be careful when using edged tools.*

**Printing a watermark on your document**

To print a watermark in the background of your printed documents or images, select the Watermark check box in the Page Layout dialog box.
Select the watermark you want to print from the Name list, then specify its position, size, color, and intensity. You can change the position and size of the watermark by dragging it with your mouse in the preview window at the left.

You can also add your own text-based or image-based watermarks to the Name list. Follow these steps.

1. Click the Add/Del button beside the Name list. The following dialog box appears.
2. To use an image file as a watermark, click the Add PICT button. Specify the desired image file, then click Open.

To create a text-based watermark, click the Add Text button. Type the text in the Text box, select a font and a text style, then click OK.

3. The image file name or the watermark text appears in the Mark Name list in the Watermark dialog box. To change the name of an image watermark, click it in the list, then type a new name. When a text watermark is selected in the Name list, you can edit the text, and change the font and text style, by clicking the Edit Text button.
4. Click OK to add your watermark to the Name list in the Page Layout dialog box.

**Setting the Print Time**

You can specify the time that you want the printer to begin printing your document. Follow these steps.

1. Click the Background Printing icon button in the Print dialog box. The Background Printing dialog box opens.

2. Select **On** as the Background Printing option, if necessary.

3. Select **Urgent**, **Normal**, **Print at**, or **Hold** as the Print Time option.

   If you select **Print at**, use the arrows beside the date and time boxes to specify the date and time you want to print the document.

   **Note:**
   *Make sure the computer and printer will be turned on at the date and time you specify.*

4. Click OK. The Background Printing dialog box closes.

5. In the Print dialog box, make sure your print settings are as you want them, then click **Print**.
Note:
You can check or change the priority of print jobs using the EPSON Monitor3 utility. See “Using EPSON Monitor3” on page 5-4 for details.

**Saving spool data as a file**

You can save spool data as a file by using the Save File icon button in the Print dialog box. This feature lets you print the document using the saved spool data at a later time simply by double-clicking the saved file. Follow these steps.

**Note:**
Use the Preview icon button to switch between the Print, Preview, and Save File modes. Click the icon to select the mode you want.

1. Make your printer driver settings.

2. Click the Preview icon button in the Print dialog box repeatedly until the Print button changes into the Save File button.

3. Click the Save File button. The following dialog box appears.

4. Select the location where you want to save the file, then type a file name into the Save As box and click Save.
5. When you want to print the document, double-click the file to open EPSON Monitor3, make sure that the correct document is selected, then click the Resume button to send the data to the printer.

**Previewing your printout**

The Preview feature allows you to see how your document will look before actually printing it. Follow these steps to preview your document.

1. Make your printer driver settings.

2. Click the Preview icon button in the Print dialog box. The Print button changes into a Preview button.

   **Note:**
   Use the Preview icon button to switch between the Print, Preview, and Save File modes. Click the icon to select the mode you want. For information on the Save File mode, see “Saving spool data as a file” on page 4-25.
3. Click the Preview button. The Preview dialog box appears and displays a preview of your document.

The Preview dialog box contains six icon buttons that you can use to perform the following functions.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection</td>
<td>Click this button to select, move, and resize watermarks.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Click this button to enlarge or reduce the size of the previewed page.</td>
</tr>
<tr>
<td>Margin</td>
<td>Click this button to display or hide borderlines which indicate the</td>
</tr>
<tr>
<td>display/</td>
<td>printable area.</td>
</tr>
<tr>
<td>non-</td>
<td>display</td>
</tr>
<tr>
<td>Watermark</td>
<td>Click this button to open the Watermark Edit dialog box, where you can</td>
</tr>
<tr>
<td>editing</td>
<td>add watermarks to the document and change any of the current watermark</td>
</tr>
<tr>
<td></td>
<td>settings.</td>
</tr>
<tr>
<td>Add page</td>
<td>Click these buttons to add or remove the highlighted pages from the list</td>
</tr>
<tr>
<td>Remove</td>
<td>of pages to be printed.</td>
</tr>
<tr>
<td>page</td>
<td></td>
</tr>
</tbody>
</table>
4. If you are satisfied with the previewed image, click Print.

If you are not satisfied with the appearance of the image, click Cancel. The Preview and Print dialog boxes close with the current print settings preserved. Open the Print dialog box again to make additional changes to the print settings.

---

**Using the Printer Utilities**

EPSON printer utilities allow you to check the current printer status and to perform printer maintenance from your computer screen. To access the utilities, click the Utility icon button in the Print or Page Setup dialog box, then click the button for the utility you want to use.

![EPSON StatusMonitor]

**EPSON StatusMonitor**

The StatusMonitor utility monitors the printer status. If it detects a printer error, it will inform you with an error message.

You can also use this utility to check how much ink is remaining before printing.
To use the StatusMonitor, click the EPSON StatusMonitor button in the Utility dialog box. For details, see “Using EPSON StatusMonitor” on page 5-1.

Note:
Do not use the Nozzle Check, Head Cleaning, or Print Head Alignment utilities while printing is in progress; otherwise, your printout may be marred.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for clogging. Check the nozzles if you notice print quality has declined and also after cleaning to confirm that the print head nozzles have been cleaned. If the nozzle check indicates the print head needs cleaning, you can access the Head Cleaning utility directly from the Nozzle Check utility. For details, see “Checking the Print Head Nozzles” on page 8-1.

Head Cleaning

This utility cleans the print head. You may need to clean the head if you notice print quality has declined. Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. For details, see “Cleaning the Print Head” on page 8-3.

Print Head Alignment

This utility aligns the print head. Use this utility if you notice a misalignment of vertical or horizontal lines.
Configuration

Clicking this button opens the Configuration dialog box, where you can change the way the StatusMonitor utility notifies you when the printer status changes. For details, see “Using the Configuration Settings dialog box” on page 5-2.
Chapter 5

Checking Printer Status and Managing Print Jobs for Macintosh

Using EPSON StatusMonitor

EPSON StatusMonitor monitors the printer. If it detects a printer error, it will inform you with an error message.

When the ink runs low or out, a How to button appears. Click How to and EPSON StatusMonitor will lead you step-by-step through the ink cartridge replacement procedure.

You can also use this utility to check ink levels before printing. When open, EPSON StatusMonitor displays the amount of ink remaining at the time it was opened. To update the ink level information, click the Update button.
Accessing EPSON StatusMonitor

Follow the steps below to access EPSON StatusMonitor.

1. Click Print or Page Setup on the File menu of your application. The Print dialog box opens.

2. Click the StatusMonitor icon button or click the Utility icon button and then the EPSON StatusMonitor button in the Utility dialog box. The StatusMonitor dialog box opens.

Using the Configuration Settings dialog box

To change the way in which the StatusMonitor utility monitors your printer, or to change the way that your printer handles print jobs, follow the steps below.

1. Click Print or Page Setup on the File menu of your application.

2. Click the Utility icon button.
3. Click the Configuration button. The Configuration Settings dialog box appears.

In the Configuration Settings dialog box, you can make the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error notification</td>
<td>Choose the method by which EPSON StatusMonitor will notify you in case of an error.</td>
</tr>
<tr>
<td>Warning</td>
<td>Choose the method by which EPSON StatusMonitor will notify you if a warning message becomes necessary.</td>
</tr>
<tr>
<td>Temporary Spool folder</td>
<td>Specify the folder in which print data will be temporarily spooled.</td>
</tr>
<tr>
<td>Temporary High Speed Copies folder</td>
<td>Specify the folder in which multiple-copy print data will be temporarily stored.</td>
</tr>
<tr>
<td>Data will be sent to the printer after being stored on your disk.</td>
<td>Select this check box to prevent horizontal banding in printouts that contain images by having the computer temporarily store image data on its hard drive. The computer will then send the image data to the printer as a whole rather than as rectangular bands.</td>
</tr>
<tr>
<td>Check for errors before starting to print.</td>
<td>Select this check box to have the printer check for errors before starting to print.</td>
</tr>
</tbody>
</table>
Using EPSON Monitor3

After you send a print job to the printer, you can use the EPSON Monitor3 utility to check, cancel, or change the priority of print jobs that are queued for printing. This utility also shows the status of the job currently being printed.

Accessing EPSON Monitor3

To access EPSON Monitor3, follow these steps.

1. First, turn on Background Printing in the Chooser or in the Background Printing dialog box.
2. Send a print job to the printer.
3. Select EPSON Monitor3 from the Application menu at the right end of the menu bar. The EPSON Monitor3 dialog box opens.
Managing print jobs using EPSON Monitor3

Using EPSON Monitor3, you can manage print jobs as described below:

- Use the buttons below to hold, resume, and delete print jobs. Select the print job that you wish to manage, then click the appropriate button.

<table>
<thead>
<tr>
<th></th>
<th>Hold</th>
<th>Resume</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pauses printing and keeps the current print job at the top of the print queue</td>
<td>Resumes printing</td>
<td>Stops printing and deletes the print job from the print queue</td>
</tr>
</tbody>
</table>

- Click Stop Print Queue to stop printing. Click Start Print Queue to resume printing.

- Use the buttons below to start the printer utilities.

<table>
<thead>
<tr>
<th></th>
<th>Print head cleaning</th>
<th>StatusMonitor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Starts the Print Head Cleaning utility</td>
<td>Starts EPSON StatusMonitor, which displays the amount of ink remaining</td>
</tr>
</tbody>
</table>

- Double-click a file in the list to preview it (this function is disabled when you are printing the ESC/P command file).

- Double-click Copies to change the number of copies of the selected print job that will be printed.
Click the Show details arrow to open an extension at the bottom of the EPSON Monitor3 dialog box, similar to the one below. The extension displays detailed information on the selected document’s printer driver settings.

---

### Changing the priority of print jobs

To change the priority of print jobs in a print queue, follow the steps in this section.

**Note:**
*You can also change the priority of print jobs whose print times were previously set in the printer driver’s Background Printing dialog box.*

1. In the Document Name column, select the print job for which you wish to change the priority.
2. Click the Show details arrow to open an extension at the bottom of the EPSON Monitor3 dialog box, similar to the one below.

![EPSON Monitor3 dialog box](image)

3. From the Priority list, select Urgent, Normal, Hold, or Print Time.

**Note:**
*If you select Print Time, a dialog box opens where you can specify the date and time that the document will print. Make sure that your printer and computer are turned on at the specified time.*
For Windows Me, 98 and 95 Users

This section tells you how to set up your printer so that other computers on a network can use it.

First, you need to set up the printer as a shared printer on the computer to which the printer is connected. Then, you must specify the network path to the printer from each computer that will use it and install the printer software on those computers.

Note:
This section describes how to use your printer as a shared printer on a network. To connect your printer directly to a network without setting it up as a shared printer, consult your network administrator.

Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the steps below to configure to computer to which the printer is connected.

1. Click Start, point to Settings, then click Control Panel.
2. Double-click the Network icon.
3. Click the File and Print Sharing button.
4. Select the I want to be able to allow others to print to my printer(s) check box and click OK.

5. In the Network dialog box, click OK.

6. In the Control Panel, double-click the Printers icon.

**Note:**

- If a dialog box requesting the insertion of the Windows Me, 98 or 95 CD-ROM appears, insert the CD in the CD-ROM drive and follow the on-screen instructions.

- If a dialog box requesting that you to restart your computer appears, do so. Then, open the Printers folder, and continue from step 7.

7. Select the icon for your printer in the Printers folder, then click Sharing on the File menu.
8. Select Shared As, then type the printer information as required and click OK.

![](image)

**Accessing the printer through a network**

To access your printer from other computers on a network, follow the steps below for each computer that will access the printer.

**Note:**
*Your printer must be set up as a shared resource on the computer to which it is directly connected before you can access it from another computer. For instructions, see “Setting up your printer as a shared printer” on page 6-1.*

1. Click Start, point to Settings, and click Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard screen opens.

3. Click Next.
4. Select Network printer, then click Next.

5. Click Browse.

6. Double-click the icon of the computer that is directly connected to the printer. Then, click the icon for the appropriate printer.

7. Click OK and follow the on-screen instructions.
For Windows 2000 and NT 4.0 Users

This section tells you how to set up your printer so that other computers on the network can use it.

Note:
- This section is written for small network users only. If you are on a large network and would like to share your printer, consult your network administrator.

- The screens shown in this section are from Windows NT 4.0.

First, you need to set up the printer as a shared printer on the computer to which the printer is connected. Then, you must specify the network path to the printer from each computer that will use it and install the printer software on those computers.

Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the steps below to configure the computer to which the printer is connected.

1. Click Start, point to Settings, and click Printers.

2. Select the icon for your printer, then click Sharing on the File menu.
3. Click Shared (for Windows 2000 users, select Shared as), then type the Share Name.

4. Click OK.

**Note:**
For Windows NT 4.0 users, do not select a driver from the Alternate Drivers list. For Windows 2000 users, do not select a driver from Additional Drivers list in the Additional Drivers dialog box.

**Accessing the printer through a network**

To access your printer from other computers on the network, follow the steps in this section for each computer that will access the printer.

**Note:**
Your printer must be set up as a shared resource on the computer to which it is directly connected before you can access it from another computer. For instructions, see “Setting up your printer as a shared printer” on page 6-5.

1. Install the printer driver from the software CD-ROM.
2. Click Start, point to Settings, and then click Control Panel.

3. Double-click the Printers icon.

4. Right-click the icon for your printer, then click Properties on the menu that appears. The printer driver opens.

5. Click the Ports tab, then click Add Port.
6. In the Printer Ports dialog box, select Local Port, then click New Port.

7. In the Port Name dialog box, enter the path information for your printer using the format below: \\
name of computer that is connected to the printer\name of the shared printer.

8. Click OK to return to the Printer Ports dialog box.

9. Click Close to return to the Ports menu.
10. On the Ports menu, make sure that the new port is included in the list and that the corresponding check box is selected. Click OK to close the printer driver.

For Macintosh Users

This section tells you how to set up the printer so that you can use it on an AppleTalk network. By setting up your printer as a shared printer, your local printer is connected to the network and can be used by other computers.

First, you need to set up the printer as a shared printer on the computer to which the printer is connected. Then, you must specify the network path to the printer from each computer that will use it, and install the printer software on those computers.

Setting up your printer as shared printer

To share a printer with other computers on an AppleTalk network, follow these steps below to configure the computer to which the printer is connected.
1. Turn on the printer.

2. Choose Chooser from the Apple menu and click the icon for your printer. Then, select the port to which the printer is connected.

3. Click the Setup button. The Printer Sharing Setup dialog box appears.

4. Select the Share this Printer check box, then type the printer name and password information as necessary.

5. Click OK. The name of the shared printer appears in the port list in the Chooser.

6. Close the Chooser.
Accessing the printer through a network

To access your printer from other computers on a network, follow the steps in this section for each computer that will access the printer.

1. Turn on your printer.

2. Install the printer driver from the software CD-ROM.

3. Choose Chooser from the Apple menu. Then, click the appropriate printer icon and select the printer port that you want to use from the Select a printer port list.

Note: Only printers that are connected to your current AppleTalk zone are available.

4. If the following dialog box appears, enter the password for the printer, then click OK.
5. Select the appropriate Background Printing radio button to turn background printing on or off.

6. Close the Chooser.
Replacing Ink Cartridges

Chapter 7

Replacing Ink Cartridges

Using the Printer's Control Panel

This printer uses ink cartridges equipped with IC chips. The IC chip accurately monitors the amount of ink used by each cartridge, so even if a cartridge is removed and later inserted again, all of its ink can be used. However, some ink is consumed each time the cartridge is inserted because the printer automatically checks reliability.

You can replace an ink cartridge using the printer’s control panel or using the Status Monitor utility. To replace an ink cartridge using the ink cartridge replacement button on the printer’s control panel, follow the steps below. To replace an ink cartridge or check ink levels using the Status Monitor utility, refer to “Using the Status Monitor” on page 7-7.

Warning:

- Keep ink cartridges out of the reach of children. Do not allow children to drink from or otherwise handle the cartridges.

- Be careful when you handle the used ink cartridges, as there may be some ink around the ink supply port. If ink gets on your skin, wash the area thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a physician immediately.
Caution:

EPSON recommends the use of genuine EPSON ink cartridges. Other products not manufactured by EPSON may cause damage to your printer not covered by EPSON’s warranties.

Leave the old cartridge installed in the printer until you have obtained a replacement; otherwise, ink remaining in the print head nozzles may dry out.

Do not refill the ink cartridges. The printer calculates the amount of ink remaining using an IC chip on the ink cartridge. Even if the cartridge is refilled, the amount of ink remaining will not be recalculated by the IC chip and the amount of ink available for use will not change.

Note:

You cannot continue printing with one ink cartridge empty, even if the other cartridge still contains ink. Before printing, replace the empty cartridge.

In addition to the ink used during document printing, ink is consumed during the print head cleaning operation, during the self-cleaning cycle which is performed when the printer is turned on, and during ink charging when the ink cartridge is installed in the printer.

For more information about ink cartridges, see “When handling the ink cartridges” on page -7.

1. Make sure that the printer is on, but not printing. Then, open the printer cover.

Note:
You can identify the status of the printer condition. When the error light is flashing, black or color ink cartridge is low. When the error light is on, black or color ink cartridge is empty.
2. Press down the ink cartridge replacement button. The print head moves left to the Ink cartridge replacement position. The power light begins to flash, and the error light begins to flash or remains on. To discover which cartridge requires replacing, refer to the table below, or check EPSON Status Monitor 3 (for Windows) or EPSON StatusMonitor (for Macintosh).

<table>
<thead>
<tr>
<th>Lights</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌋 🔵</td>
<td>Replace the black ink cartridge if the error light flashes at the same speed as the power light. Black ink cartridge: T007 (Standard capacity) T010 (Light capacity)</td>
</tr>
<tr>
<td>🌋 🔵</td>
<td>Replace the color ink cartridge if the error light flashes at twice the speed of the power light. Color ink cartridge: T008</td>
</tr>
<tr>
<td>⚫ 🔵</td>
<td>Replace both the black and color ink cartridges if this light remains on.</td>
</tr>
</tbody>
</table>

* = on, ○ = off, 🔵 = flashing

**Caution:**
Do not move the print head by hand, as this may damage the printer. Always press the ink cartridge replacement button to move it.
3. Lift up the ink cartridge clamp as far as it will go. Take the cartridge out of the printer. If the cartridge is empty, dispose of it properly. Do not take the used cartridge apart or try to refill it.

**Warning:**
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a physician immediately.

4. Remove the new ink cartridge from its protective bag and then only peel off the yellow tape seal. Do not touch the green chip on the side of the cartridge.

black ink cartridge:
- T007 (Standard capacity)
- T010 (Light capacity)

color ink cartridge: T008
Caution:

- You must remove the yellow tape seal from the cartridge before installing it; otherwise, the cartridge will become unusable and you will be unable to print.

- If you have installed an ink cartridge without removing the yellow tape seal, you must remove the cartridge and install a new one. Prepare the new cartridge by removing the yellow tape seal, then install it in the printer.

- Do not remove the blue portion of the tape seal from the top of the cartridge; otherwise, the print head may become clogged and be unable to print.

- Do not remove the tape seal from the bottom of the cartridge; otherwise, ink will leak.

- Do not touch the green IC chip on the side of the cartridge; otherwise, normal operation and printing may not be possible.

- Do not remove the green IC chip from the side of the cartridge. If you install an ink cartridge without an IC chip, the printer may be damaged.

5. Align the tabs on the ink cartridge so that they are resting on the tabs protruding from the base of the opened ink cartridge clamp. Push the clamps down until they lock firmly into place.
Caution:

- Make sure that the ink cartridge tabs are not under the hinges protruding from the base of the opened ink cartridge clamp, as this could damage the clamp.

- After you remove an ink cartridge from the printer, please insert a new one immediately. If no cartridge is present, the print head may dry out and become unable to print.

6. Press the ink cartridge replacement button. The printer moves the print head and begins charging the ink delivery system. This process takes about one minute to complete. When the ink charging process is finished, the printer returns the print head to its home position, the power light stops flashing and remains on and the error light goes out.
Caution:
The power light continues to flash while the printer is charging ink. Never turn off the printer while this light is flashing. Doing so can result in incomplete charging of ink.

7. Close the printer cover.

Using the Status Monitor

You can monitor the remaining ink levels from your computer and view on-screen instructions for replacing a low or empty ink cartridge using EPSON Status Monitor 3 (for Windows) or EPSON StatusMonitor (for Macintosh).

When an ink cartridge is low or empty, click the How to button in the EPSON Status Monitor window. Follow the on-screen instructions to replace the cartridge.

For more information on using EPSON Status Monitor, see “Using EPSON Status Monitor 3” on page 3-3 for Windows, or “Using EPSON StatusMonitor” on page 5-1 for Macintosh.
Chapter 8

Maintenance

Checking the Print Head Nozzles

If you find that the printed image is unexpectedly faint or dots in the printed image are missing, you may be able to identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer using the Nozzle Check utility in the printer software, or from the printer itself by using the printer’s control panel buttons.

Using the Nozzle Check utility

Refer to the appropriate section below to use the Nozzle Check utility.

Note:
Do not use the Nozzle Check utility while printing is in progress; otherwise, your printout may be marred.

For Windows users

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet feeder.

2. Access the printer software. If you need instructions, see “Accessing the printer software” on page 2-2.

3. Click the Utility tab, then click the Nozzle Check button.

4. Follow the on-screen instructions.
For Macintosh users

Follow the steps below to use the Nozzle Check utility.

1. Access the Print or Page Setup dialog box and click the Utility icon button, then click the Nozzle Check button in the Utility dialog box.

2. Follow the on-screen instructions.

Using the control panel buttons

Follow the steps below to check the print head nozzles using the control panel buttons.

1. Turn off your printer.

2. Make sure that A4 or Letter size paper is loaded in the sheet feeder.

3. Hold down the \( \text{△} \text{-} \text{□} \) maintenance button (① in the illustration below) and press the \( \text{○} \) power button (② in the illustration below) to turn on the printer.

4. Release only the power button first. When the nozzle check starts, release the \( \text{△} \text{-} \text{□} \) maintenance button.
The printer prints an operation check page that includes your printer’s ROM version information, the ink counter code, and a nozzle check pattern. Below are sample printouts.

Good sample

![Good sample]

Print head needs to be cleaned

![Print head needs to be cleaned]

The above sample is in black and white, but the actual test prints in color (CMYK).

If the nozzle check page does not print satisfactorily (for example, if any segment of the printed lines is missing), there is a problem with the printer. This could be a clogged ink nozzle or a misaligned print head. See the next section for details on cleaning the print head. For information on aligning the print head, see “Aligning the Print Head” on page 8-8.

**Cleaning the Print Head**

If you find that the printed image is unexpectedly faint or dots in the printed image are missing, you may be able to solve these problems by cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the printer software, or from the printer itself by using the printer’s control panel buttons.
Note:
- Print head cleaning uses both color and black ink. To avoid wasting ink, clean the print head only if print quality declines; for example, if the printout is blurry or the color is incorrect or missing.
- Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves ink.
- When the error light is flashing or on, you cannot clean the print head. Replace the appropriate ink cartridge first.
- Do not start the Head Cleaning or Nozzle Check utility while printing is in progress; otherwise, your printout may be marred.

Using the Head Cleaning utility

Refer to the appropriate section below to use the Head Cleaning utility.

For Windows users

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure that the printer is on and the error light is off.

   Note:
   If the error light is flashing, you cannot clean the print head. Replace the appropriate ink cartridge first.

2. Access the printer software. For instructions, see “Accessing the printer software” on page 2-2.

3. Click the Utility tab, then click the Head Cleaning button.

4. Follow the on-screen instructions.

   The power light flashes while the printer performs the cleaning cycle. It takes about thirty seconds to complete.
Caution:
Never turn off the printer while the power light is flashing. Doing so may damage the printer.

5. When the power light stops flashing, click Print nozzle check pattern in the Head Cleaning dialog box to confirm that the head is clean and to reset the cleaning cycle.

Below are nozzle check patterns:

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual check pattern prints in color.

In the check pattern, if you find that any segments are missing from the test lines, you may need to repeat the head cleaning and print the nozzle check pattern again.

If print quality hasn’t improved after repeating this procedure four or five times, turn the printer off and leave it alone overnight. Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink cartridges may be old or damaged and may need to be replaced. To replace an ink cartridge before it is empty, see “Replacing Ink Cartridges” on page 7-1.

If print quality remains a problem after replacing the ink cartridges, contact your dealer.
Note:
To maintain print quality, we recommend turning on the printer for at least one minute every month.

For Macintosh users

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure that the printer is on and the error light is off.

2. Access the printer software and click the Utility icon button, then click the Head Cleaning button.

3. Follow the on-screen instructions.

The power light flashes while the printer performs the cleaning cycle. This operation takes about thirty seconds to complete.

Caution:
Never turn off the printer while power light is flashing. Doing so may damage the printer.

4. When the power light stops flashing, click the Confirmation button in the Head Cleaning dialog box to print a nozzle check pattern and to reset the cleaning cycle. Use the check pattern to confirm the head is clean. Refer to page 148 to see a sample of the nozzle check pattern.

If print quality hasn’t improved after repeating this procedure four or five times, turn the printer off and leave it alone overnight. Then, do the head cleaning again.

If the print quality still has not improved, one or both of your ink cartridges may be old or damaged and may need to be replaced. To replace an ink cartridge, see “Replacing Ink Cartridges” on page 7-1.
If print quality remains a problem after replacing the ink cartridges, contact your dealer.

*Note:*
To maintain print quality, we recommend turning on the printer for at least one minute every month.

**Using the control panel buttons**

Follow the steps below to clean the print head using the control panel buttons.

1. Make sure that the power light is on and that the error light is off.

   *Note:*
   If the error light is flashing or on, you cannot clean the head and this operation will start the ink cartridge replacement procedure. If you do not want to replace an ink cartridge at this moment, press the maintenance button to return the print head to its home position.

2. Hold down the maintenance button for three seconds.
The printer starts cleaning the print head and the power light begins flashing. Print head cleaning takes about thirty seconds to complete.

**Caution:**

*Never turn off the printer while the power light is flashing. Doing so may damage the printer.*

3. When the power light stops flashing, print a nozzle check pattern to confirm that the head is clean and to reset the cleaning cycle.

If print quality hasn’t improved after repeating this procedure four or five times, turn the printer off and leave it alone overnight. Then, do the head cleaning again.

If the print quality still has not improved, one or both of your ink cartridges may be old or damaged and may need to be replaced. To replace an ink cartridge before it is empty, see “Replacing Ink Cartridges” on page 7-1.

If print quality remains a problem after replacing the ink cartridges, contact your dealer.

**Note:**

*To maintain print quality, we recommend turning on the printer for at least one minute every month.*

### Aligning the Print Head

If you notice a misalignment of vertical lines, you may be able to solve this problem from your computer using the Print Head Alignment utility in your printer software. Refer to the appropriate section below.
Note:
Do not start the Print Head Alignment utility while printing is in progress; otherwise, your printout may be marred.

For Windows users

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that A4 or Letter size plain paper is loaded in the sheet feeder.

2. Access the printer software. For instructions, see “Accessing the printer software” on page 2-2.

3. Click the Utility tab, then click the Print Head Alignment button.

4. Follow the on-screen instructions to align the print head.

For Macintosh users

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that A4 or Letter size plain paper is loaded in the sheet feeder.

2. Access the printer software and click the Utility icon button, then click the Print Head Alignment button.

3. Follow the on-screen instructions to align the print head.
Cleaning the Printer

To keep your printer operating at its best, clean it thoroughly several times a year as follows.

1. Unplug the printer’s power cord.
2. Remove any paper from the sheet feeder.
3. Use a soft brush to carefully clean away all dust and dirt from the sheet feeder.
4. If the outer case or the inside of the sheet feeder is dirty, clean it with a soft, clean cloth dampened with mild detergent. Keep the printer cover closed to prevent water getting inside.
5. If the inside of the printer accidentally gets soiled with ink, wipe it off with a damp cloth.

**Warning:**
Be careful not to touch the gears or rollers inside the printer.

**Caution:**
- Be careful not to wipe grease on the metal parts under the ink carriage passage.
- Never use alcohols or thinners to clean the printer; these chemicals can damage the components as well as the case.
- Be careful not to get water on the printer mechanism or electronic components.
- Do not use a hard or abrasive brush.
- Do not spray the inside of the printer with lubricants; unsuitable oils can damage the mechanism. Contact your dealer or a qualified service person if lubrication is needed.
Transporting the Printer

If you need to transport your printer, carefully prepare and repack it as described below using the original box (or a similar box that the printer fits snugly into) and packing materials. Follow the steps below.

1. Open the printer cover and make sure that the print head is in the home (far right) position. If not, plug in the printer and wait until the print head returns to the home position. Then close the printer cover and unplug the printer.

   Caution:
   Leave the ink cartridges installed when you transport the printer. Transporting the printer without cartridges installed can damage the printer.

2. Disconnect the interface cable from the printer.

3. Remove the paper from the sheet feeder and remove the paper support.

4. Open the printer cover again. Secure the ink cartridge holder to the printer with tape as shown below, then close the printer cover.

5. Push in the output extension tray, then raise the output tray.

6. Attach the protective materials to both sides of the printer.
7. Repack the printer and power cord in the original box.

8. Keep the printer level during transport.

---

**Updating and Uninstalling Software**

Follow the directions in this section if you have updated your computer, want to update your printer software from a previous version, or need to uninstall printer driver.

**Updating to Windows 98**

If you have upgraded your computer’s operating system from Windows 95 to Windows 98, you must uninstall your printer software and then install it again. Uninstall the printer software by double-clicking the Add/Remove Programs icon in the Windows Control Panel and selecting EPSON Printer Software from the list. Click the Add/Remove button. The EPSON Printer Software Uninstall dialog box appears. Select the printer model and click OK. Then, install the printer software again.

**Updating Windows Me**

If you are using parallel cable connection and you have upgraded your computer’s operating system from Windows 98 or 95 to Windows Me, you must uninstall your printer software and then install it again. Uninstall the printer software by double-clicking the Add/Remove Programs icon in the Windows Control Panel and selecting EPSON Printer Software from the list. Click the Add/Remove button. The EPSON Printer Software Uninstall dialog box appears. Select the printer model and click OK. Then, install the printer software again.
**Updating the driver in Windows 2000 and NT 4.0**

When you update the printer driver in Windows 2000 and NT 4.0, please be sure to uninstall the previous printer driver before you install the new driver. Installing over the existing printer driver results in a failure to update. To uninstall the printer driver, double-click the Add/Remove Programs icon in the Windows Control Panel. The Add/Remove Programs Properties dialog box appears. Select EPSON Printer Software from the list and click Change/Remove (Windows 2000) or Add/Remove (Windows NT 4.0). The EPSON Printer Software Uninstall dialog box appears. Select the printer model and click OK.

**Uninstalling the printer driver**

**For Windows**

1. Turn off the printer and disconnect the cable from the printer.

2. Click the Start button and select Settings, then choose Control Panel.

3. Double-click the Add/Remove Program icon and select EPSON Printer Software from the list. Then, click the Add/Remove button.

4. Select the Stylus Photo 790 icon and click OK.

5. Select OK.

**Note:**
If you are a Windows Me or 98 user, and using USB port, you also need to uninstall the USB printer. First, you must uninstall the EPSON USB printer and EPSON Status Monitor3. Then follow steps 1 and 2 above, and select EPSON USB printer device from the list. Click the Add/Remove button and click OK when the message telling you to reboot the computer is displayed.
For Macintosh

1. Turn on your Macintosh and insert the software CD in the CD-ROM drive. The EPSON printer software disk will open automatically.

2. If a single Installer icon appears, double-click the icon. If separate folders containing installer icons for several languages appear, double-click the folder for your preferred language, then double-click the Installer icon inside it.

3. After the initial screen, click Continue. The following dialog box will appear.

4. Select Uninstall from the pull-down menu at the top left.

5. Click Uninstall.
Chapter 9

Troubleshooting

Correcting USB Problems

If you are having difficulty using your printer with a USB connection, read the information in this section.

Printer does not work correctly with the USB cable

If your printer does not work correctly with the USB cable, try one or more of these solutions:

- Use the USB cable (C83623*) recommended in “System Requirements” on page A-11.

- For best results, you should connect the printer directly to the computer’s USB port. If you must use multiple USB hubs, we recommend that you connect the printer to the first tier hub.

- For Windows Me and 98, try reinstalling the USB printer device driver and the printer software. First, uninstall EPSON Printer Software using the Add/Remove Programs utility in the Control Panel, then uninstall EPSON USB Printer Devices. Next, reinstall the software as described in Setup Guide. If EPSON USB Printer Devices is not registered in the Add/Remove Programs list, access the CD-ROM and double-click epusbun.exe in Win9x folder. Then follow the on-screen instructions.
**Operating system**

Your computer must be a Windows Me, 98 or Windows 2000 pre-installed model. You may not be able to install or run the USB Printer Driver on a computer which is not equipped with a USB port or which has been upgraded from Windows 95 to Windows 98 or 2000. For Windows Me users, your computer must be a Windows Me pre-install model or upgraded from Windows 98 pre-installed model.

For details about your computer, contact your dealer.

**Printer software installation**

Please take notice about the following.

- When using Windows 2000, you must follow the steps in the *Setup Guide* to install the printer software; otherwise, Microsoft’s Universal driver may be installed instead. To check if the Universal driver has been installed, open the Printers folder and right-click the icon for your printer. To open the printer driver, click *Printing Preferences* on the shortcut menu that appears, then right-click anywhere in the driver. If *About* is displayed in the shortcut menu that appears, click it. A message box with the words “Unidrv Printer Driver” appears. You must reinstall the printer software as described in the *Setup Guide*. If *About* is not displayed, the printer software has been installed correctly.

- If the Digital Signature Not Found dialog box appears during the installation process, click *Yes*. If you click *No*, you must follow the steps in the *Setup Guide* to install the printer software again.
USB driver installation

For Windows Me, 98 and 2000 users, follow the directions below to ensure that the USB driver is installed correctly.

Note:
The illustrations used in this section show the procedure for Windows 98.

1. Click the Start button, point to Settings, and click Printers. Make sure that the icon for your printer appears in the Printers window.

Select the icon for your printer, then click Properties on the File menu.
2. For Windows Me and 98 users, click the Details tab and make sure that EPUSBx: (EPSON Stylus PHOTO 790) is displayed in the Print to the following port list box. For Windows 2000 users, click the Ports tab and make sure that USBxxx, EPSON Stylus PHOTO 790 is displayed in the Print to the following port(s) list box.

![Printer Configuration Window]

**Note:**
*If the correct port is not displayed, refer to the next section, “The Device Manager menu (for Windows Me and 98)”.

**The Device Manager menu (for Windows Me and 98)**

If you canceled the plug-and-play driver installation before the procedure was complete, either the USB printer device driver or the printer driver may be incorrectly installed.

Follow the steps below to check the installation and reinstall the drivers.
1. Turn the printer on. Plug the USB cable into the printer and the computer.

2. Right-click the My Computer icon on your desktop, then click Properties.

3. Click the Device Manager tab.

If your drivers are correctly installed, EPSON USB Printer Devices should appear on the Device Manager menu.

If EPSON USB Printer Devices does not appear on the Device Manager menu, click the plus (+) sign beside Other devices to view the installed devices.

If USB Printer appears under Other devices, the USB printer device driver is not installed correctly. If EPSON Stylus PHOTO 790 appears, the printer driver is not installed correctly.
If neither USB Printer nor EPSON Stylus PHOTO 790 appears under Other devices, click Refresh or unplug the USB cable from the printer, then plug it into the printer again.

4. Under Other devices, select USB Printer or EPSON Stylus PHOTO 790 and click Remove. Then, click OK.

5. When the following dialog box appears, click OK. Then click OK to close the System Properties dialog box.

6. Turn off the printer and restart your PC. Then, reinstall the drivers from the beginning, following the instructions in the Setup Guide.

Note:
If the problem persists, contact your dealer.
**Diagnosing the Problem**

Troubleshooting printer problems is best handled in two easy steps: first diagnose the problem, then apply likely solutions until the problem is fixed. The information that you need to diagnose the most common problems is provided by the Status Monitor utility.

Use the information presented in this chapter to pinpoint the source of your problem, then apply the recommended solutions until the problem is solved.
**Error indicators**

You can identify many common printer problems using the lights on your printer’s control panel. If the lights are on or flashing, use the following table of panel light patterns to diagnose the problem, then follow the recommended corrective measures.

<table>
<thead>
<tr>
<th>Lights</th>
<th>Problem and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="light" alt="Paper out" /> ![light]</td>
<td></td>
</tr>
<tr>
<td><strong>Problem:</strong> Paper out</td>
<td><strong>Solution:</strong> No paper is loaded in the printer. Check EPSON Status Monitor 3 or EPSON StatusMonitor. Load paper in the sheet feeder, then press the maintenance button. The printer resumes printing and the light goes out.</td>
</tr>
<tr>
<td><img src="light" alt="Paper jam" /> ![light]</td>
<td></td>
</tr>
<tr>
<td><strong>Problem:</strong> Paper jam</td>
<td><strong>Solution:</strong> Paper has jammed in the printer. Check EPSON Status Monitor 3 or EPSON StatusMonitor. Press the maintenance button to eject the jammed paper. If the error does not clear, open the printer cover and remove all of the paper inside, including any torn pieces. Then, reload the paper in the sheet feeder and press the maintenance button to resume printing.</td>
</tr>
<tr>
<td><img src="light" alt="Ink low" /> ![light]</td>
<td></td>
</tr>
<tr>
<td><strong>Problem:</strong> Ink low</td>
<td><strong>Solution:</strong> The black or color ink cartridge is nearly empty. Obtain a replacement black or color ink cartridge. To see which cartridge is nearly empty, check the ink level using EPSON Status Monitor 3 or EPSON StatusMonitor. Black ink cartridge: T007 (Standard capacity) T010 (Light Capacity) Color ink cartridge: T008</td>
</tr>
</tbody>
</table>
## Status Monitor

The Status Monitor utility provides status messages and a graphic display showing the current state of the printer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
</table>
| ✅ ∙          | **Ink out** The black or color ink cartridge is empty or not installed.    | Replace the black or color ink cartridge with a new one. See “Replacing Ink Cartridges” on page 7-1 for details.  
|               |                                                                            | Black ink cartridge:  
|               |                                                                            | T007 (Standard capacity)  
|               |                                                                            | T010 (Light Capacity)  
|               |                                                                            | Color ink cartridge: T008  
|               | **Wrong cartridge** The installed black or color ink cartridge cannot be used by this printer. | Use the appropriate black or color ink cartridge. See “Replacing Ink Cartridges” on page 7-1 for details.  
|               |                                                                            | Black ink cartridge:  
|               |                                                                            | T007 (Standard capacity)  
|               |                                                                            | T010 (Light Capacity)  
|               |                                                                            | Color ink cartridge: T008  
|               | **Carriage error** The print head carriage is obstructed by jammed paper or other foreign material and cannot return to the home position. | Turn off the printer. Open the printer cover and remove any paper from the paper path by hand. Then, turn the printer back on.  
|               |                                                                            | If the error does not clear, contact your dealer.  
|               | **Unknown printer error** An unknown printer error has occurred.            | Turn off the printer and contact your dealer.  

= on, = off, = flashing
If a problem occurs while printing, an error message appears in the Progress Meter window.

When the ink is out, click the How To button in the Status Monitor or Progress Meter window and EPSON Status Monitor will lead you step-by-step through the cartridge replacement procedure.

**Running a printer operation check**

Performing a printer operation check can help you determine whether the problem comes from the printer or the computer.

To print a printer operation check page, follow these steps.

1. Make sure both the printer and computer are turned off.
2. Disconnect the cable from the printer’s interface connector.
   
   If you use the parallel interface, unlock the wire clips on both sides of the interface connector and remove the ground connector, if necessary. Then disconnect the cable from the printer’s interface connector.

3. Make sure that A4 or Letter size paper is loaded in the sheet feeder.
4. Hold down the \(\text{\textbullet}\) maintenance button and press the \(\text{\textbullet}\) power button to turn on the printer. Then, release only the power button first. When the printer starts the operation check, release the \(\text{\textbullet}\) maintenance button.

The printer prints an operation check page which includes the version of your printer’s ROM, the ink counter code, and a nozzle check pattern.

Compare the quality of the printed check page with the sample shown below. If there are no print quality problems, such as gaps or missing segments in the test lines, the printer itself is all right and the problem probably lies with the printer software settings, the application settings, the interface cable (be sure to use a shielded cable), or the computer itself.

The above sample is in black and white, but the actual check page prints in color (CMYK).
If the check page does not print satisfactorily as shown below, there is a problem with the printer. For example, if any segment of the printed lines is missing, this could mean a clogged ink nozzle or a misaligned print head.

Segments are missing

The above sample is in black and white, but the actual check pattern prints in color.

---

**Cancelling Printing**

If the printouts are not what you expected and contain incorrect or garbled characters or images, you may need to cancel printing. To cancel printing, follow the instructions in the appropriate section below.

---

**For Windows users**

When you send a print job to the printer, the Progress Meter appears on your computer screen.
Click the Stop button to cancel printing.

**For Macintosh users**

The procedure for canceling printing for Macintosh varies, depending upon whether background printing is on or off. Refer to the appropriate section below.

**When background printing is on**

Follow the steps below to cancel a print job.

1. Select EPSON Monitor3 from the application menu.
2. Press the power button to turn off the printer.
3. In the Document Name list, select the document which is printing, then click the Stop icon button to cancel the print job.
When background printing is off

Follow the steps below to cancel a print job.

1. Press the power button to turn off the printer.

2. Hold down the command key on your keyboard and press the period (.) key to cancel the print job.

Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If it receives two or more print jobs at one time, it holds them in the order that they were received (with printers on a network this may be called a print queue). When a print job reaches the top of the line, the EPSON Spool Manager sends the job to the printer. From the Spool Manager, you can view print status information about the print jobs which have been sent to your printer. You can also cancel, pause and resume, or restart selected print jobs.

Note:
EPSON Spool Manager is not available for Windows 2000, Windows NT, or Macintosh.

For Windows Me, 98 and 95

After you send a print job, an EPSON Stylus PHOTO 790 button appears on the taskbar. Click this button to open the EPSON Spool Manager.
Print Quality Could Be Better

If you are having print quality problems, try the solutions offered in this section.

**Horizontal banding**

Try one or more of these solutions:

- Make sure the printable side of the paper is face up in the sheet feeder.

- Run the Head Cleaning utility to clear any clogged ink nozzles.

- Clear all settings, and select Automatic as the Mode setting on your printer software’s Main menu (Windows) or in the Print dialog box (Macintosh).

- Check the error light. If the light is flashing, replace the appropriate ink cartridge. See “Replacing Ink Cartridges” on page 7-1 for details.

- Make sure that Maximum is not selected as the Printable Area setting in your printer driver. When this setting is selected, banding may occur in the expanded area.

- Make sure that the Media Type selected in the printer driver is appropriate for the type of media loaded in the printer.

- Select Micro Wave if the setting is active.

**Vertical misalignment or banding**

Try one or more of these solutions:
- Make sure the printable side of the paper is face up in the sheet feeder.

- Run the Print Head Alignment utility.

- Clear the High Speed check box in the Advanced dialog box of your printer driver’s Advanced dialog box. For instructions, see “Making the Advanced settings” on page 2-10 for Windows. For Macintosh, see “Making the Advanced settings” on page 4-9.

- Run the Head Cleaning utility to clear any clogged ink nozzles.

- Make sure the Media Type setting selected in the printer driver is appropriate for the type of media loaded in the printer.

- Select Micro Wave if the setting is active.

- Make sure that the position of the adjust lever is appropriate for the media type. When printing on media of normal thickness, set the adjust lever to the “-” position. When printing on envelopes or thick media, set the position to “+”.

**Color gaps**

Try one or more of these solutions:

- Make sure your paper is not damaged, dirty, or too old. Also, make sure the printable side of the paper is face up in the sheet feeder.

- Run the Head Cleaning utility to clear any clogged ink nozzles.

- Check the Δ error light. If the light is flashing, replace the appropriate ink cartridge. See “Replacing Ink Cartridges” on page 7-1.
Adjust the color settings in your application or your printer driver’s Advanced dialog box. For instructions, see “Making the Advanced settings” on page 2-10 for Windows or “Making the Advanced settings” on page 4-9 for Macintosh.

Clear all settings, and select Automatic as the Mode setting on your printer software’s Main menu (Windows) or in the Print dialog box (Macintosh).

Make sure the Media Type setting selected in the printer driver is appropriate for the type of media loaded in the printer.

**Incorrect or missing colors**

Try one or more of these solutions:

- Change the Ink setting in your printer driver to Color. For instructions, see “Using the Automatic mode” on page 2-7 for Windows or “Using the Automatic mode” on page 4-6 for Macintosh.

- Adjust the color settings in your application or your printer driver’s Advanced dialog box. For instructions, see “Making the Advanced settings” on page 2-10 for Windows or “Making the Advanced settings” on page 4-9 for Macintosh.

- Run the Head Cleaning utility. If colors are still incorrect or missing, replace the color ink cartridge. If the problem persists, replace the black ink cartridge. See “Replacing Ink Cartridges” on page 7-1.

- Make sure that you are not using an ink cartridge with an expired date printed on the cartridge carton. Also, if you have not used the printer for a long time, replace with new ink cartridges. See “Replacing Ink Cartridges” on page 7-1.
Blurry or smeared printout

Try one or more of these solutions:

- Make sure that you are using the appropriate printer driver for your printer.
- Use Plain paper or paper recommended by EPSON for printing.
- Make sure that the printer is on a flat, stable surface that extends beyond the printer base in all directions. The printer will not operate properly if it is tilted.
- Make sure that your paper is not damaged, dirty, or too old. Also, make sure that the printable side of the paper is face up in the sheet feeder.
- Make sure your paper is dry and the printable side is facing up. Also, make sure you’re using an acceptable paper type. See “Paper” on page A-1 for specifications.
- Clear all settings, and select Automatic as the Mode setting on your printer software’s Main menu (Windows) or in the Print dialog box (Macintosh).
- If the paper is curled toward the printable side, flatten it or curl it slightly toward the opposite side.
- Set the adjust lever to the “+” position, and make sure that the Media Type setting in your printer driver is correct.
- Remove each sheet from the output tray as it is printed, especially if you are using transparencies.
- If you are printing on glossy media or transparencies, place a support sheet (or a sheet of plain paper) beneath the stack. Or, load one sheet at a time.
- Run the Head Cleaning utility.
Run the Print Head Alignment utility.

When printing on thick media, set the adjust lever to the “+” position.

Load and eject dry paper several times. If the problem persists, ink may have leaked inside the printer, so wipe the inside of the printer with a soft, clean cloth.

Load and eject dry paper several times. If the problem persists, ink may have leaked inside the printer, so wipe the inside of the printer with a soft, clean cloth.

**Warning:**
*Be careful not to touch the gears or rollers inside the printer.*

**Caution:**
*Be careful not to wipe grease on the metal parts under the ink carriage passage.*

---

**Printouts Are Not What You Expected**

If one of the following problems has occurred, try the solutions listed for the problem.

- Incorrect or garbled characters
- Incorrect margins
Inverted image

Blank pages print

Printout has smears on the bottom edge

Printing is too slow

**Incorrect or garbled characters**

Try one or more of these solutions:

- Make sure that your printer and printer driver are appropriately selected.

- Clear any stalled print jobs from the Spool Manager. For instructions, see “Using EPSON Spool Manager” on page 9-14.

- Turn off the printer and computer. Make sure the printer’s interface cable is securely plugged in.

- If you are using Windows NT 4.0, try to uninstall the EPSON Printer Port. Click Start, point to Programs and then to EPSON Printers, then click EPSON Printer Port Uninstall. Follow the on-screen instructions.

**Incorrect margins**

Try one or more of these solutions:

- Check the margin settings in your application. Make sure the margins are within the printable area of the page. See “Paper” on page A-1 for specifications.

- For Windows, check the settings on the Paper menu. Make sure the settings are appropriate for the paper size you are using.
For Macintosh, check the settings in the Page Setup dialog box. Make sure the settings are appropriate for the paper size that you are using.

**Inverted image**

Clear the Flip Horizontal check box in the printer driver, or turn off the “Mirror” setting in your application. For instructions, see online help for the printer driver or for your application.

Macintosh users can refer to “Making the Advanced settings” on page 4-9 for details.

**Blank pages print**

Try one or more of these solutions:

- Make sure that your printer and printer driver are appropriately selected.
- Select your printer as the default printer in Windows.
- For Windows, check the settings on the Paper menu. Make sure they are appropriate for the paper size that you are using.
- For Macintosh, check the settings in the Page Setup dialog box. Make sure they are appropriate for the paper size that you are using.
- Run the Head Cleaning utility to clear any clogged nozzles.

After trying one or more of these solutions, run a printer operation check to check your results. See “Running a printer operation check” on page 9-10 for details.
Printout has smears on the bottom edge

Try one or more of these solutions:

- If the paper is curled toward the printable side, flatten it or curl it slightly toward the opposite side.

- Set the adjust lever to the “+” position and clear the High Speed check box in your printer driver’s Advanced dialog box. The Advanced dialog box is accessible through the Main menu (Windows) or the Print dialog box (Macintosh) when Custom is selected as the Mode setting. To turn this option off, you may also need to change the Print Quality setting.

Printing is too slow

Try one or more of these solutions:

- Make sure the Media Type setting in your printer driver is correct. For instructions, see “Making the Media Type setting” on page 2-4 for Windows or “Making the Media Type setting” on page 4-2 for Macintosh.

- Select Automatic as the Mode setting on your printer driver’s Main menu (Windows) or in the Print dialog box (Macintosh) and then move the slider to Speed. For instructions, see “Using the Automatic mode” on page 2-7 for Windows or “Using the Automatic mode” on page 4-6 for Macintosh.

- Close any applications you are not using at the moment.

Printer Doesn't Print

If one of the following error indications is displayed, try the solutions listed.

- All lights are off
Lights came on and then went out

Only the power light is on

The error light is flashing or on

The error light is on and the power light is off

**All lights are off**

Try one or more of these solutions:

- Press the power button to make sure the printer is on.
- Turn off the printer and make sure the power cord is securely plugged in.
- Make sure that your outlet works and is not controlled by a wall switch or timer.

**Lights came on and then went out**

The printer’s voltage may not match the outlet rating. Turn off the printer and unplug it immediately. Then, check the printer labels.

If the voltage does not match, DO NOT PLUG YOUR PRINTER BACK IN. Contact your dealer.

**Only the power light is on**

Try one or more of these solutions:

- Turn off the printer and computer. Make sure the printer’s interface cable is securely plugged in.
- Make sure there is no packing material in the printer.
Troubleshooting

- Turn off the printer and computer and disconnect the printer’s interface cable. Then, print an operation check page. See “Running a printer operation check” on page 9-10.

  If the check page prints correctly, make sure the printer software and your application are installed correctly.

- If you are trying to print a large image, your computer may not have enough memory to print. Try printing a smaller image.

- If you are using Windows NT 4.0, try to uninstall the EPSON Printer Port. Click Start, point to Programs and then to EPSON Printers, then click EPSON Printer Port Uninstall. Follow the on-screen instructions.

- Clear any stalled print jobs from the Spool Manager. For instructions, see “Using EPSON Spool Manager” on page 9-14.

- If the printer sounds like it is trying to print, but is unable to, run the Head Cleaning utility.

  If this doesn’t work, replace the ink cartridges. See “Replacing Ink Cartridges” on page 7-1.

**Error light is flashing or on**

Check EPSON Status Monitor 3 or EPSON StatusMonitor to find the cause of the error, then try one or more of these solutions:

- If the error light is on and paper is jammed, remove any paper that may be jammed in the printer.

- If the error light is on and no paper is loaded, load more paper in the sheet feeder.

- If the error light is flashing, ink is low. Prepare a replacement cartridge.
If the error light is on and ink is out, replace the appropriate ink cartridge. See “Replacing Ink Cartridges” on page 7-1.

**Error light is on and power light is flashing**

Follow the steps below.

1. Press the maintenance button, then remove any paper in the printer.

2. Turn the printer off. Check for and remove any foreign objects or pieces of paper from inside the printer. Also, make sure that there is sufficient space around the vent on the back of the printer to allow proper ventilation. Remove any objects blocking the vent. Then, turn the printer back on.

   **Note:**
   If you cannot remove a foreign object easily by yourself, do not use force and do not disassemble the printer. Call your dealer for assistance.

3. If the error does not clear, contact your dealer.

**Paper Doesn't Feed Correctly**

If one of the following problems has occurred, try the solution(s) listed for the problem.

- Paper doesn't feed
- Multiple pages feed
- The paper jams
- Paper isn't ejected fully or is wrinkled
**Paper doesn't feed**

Remove the stack of paper and make sure of the following:

- The paper isn’t curled or creased.
- The paper isn’t too old. See the instructions that came with the paper for more information.
- The paper isn’t loaded above the arrow on the left edge guide.
- Paper isn’t jammed inside. If it is, remove the jammed paper.
- The black and/or color ink cartridges are not out. If one is, replace the appropriate cartridge. See “Replacing Ink Cartridges” on page 7-1.

Then, load the paper again. Make sure you follow any special loading instructions that came with your paper. See also “Paper Handling” on page 19.

**Multiple pages feed**

- Make sure that the paper stack fits under the arrow mark located on the inside surface on the left edge guide.
- Make sure that the left edge guide is snug to the left edge of the paper.
- Make sure that the paper is not curled or folded. If so, flatten it or curl it slightly toward the opposite side before loading.
- Make sure that the position of the adjust lever is appropriate for the media type. When printing on media of normal thickness, set the adjust lever to the “-” position. When printing on envelopes and thick media, set the position to “+”.

---

9-26  Troubleshooting
Remove the stack of paper and make sure the paper is not too thin. See “Paper” on page A-1 for specifications. Fan the edges of the stack to separate the sheets, then reload the paper.

If too many copies of a document are being printed, check the Copies setting on the printer driver’s Paper menu (for Windows) or in the Print dialog box (for Macintosh) and in your application. For instructions, see “Modifying the printout style” on page 2-17 for Windows, or “Making Changes to Printer Settings” on page 4-1 for Macintosh.

The paper jams

Press the □ □ maintenance button to eject the jammed paper. If the error does not clear, open the printer cover and remove all of the paper inside, including any torn pieces. Then, reload the paper in the sheet feeder and press □ □ maintenance button to resume printing.

Note:
If you cannot remove a foreign object easily by yourself, do not use force and do not disassemble the printer. Call your dealer for assistance.

If your paper jams frequently, make sure of the following:

- The paper is smooth, not curled or wrinkled.
- Make sure that the printable side of the paper is face up in the sheet feeder.
- The paper stack was fanned before loading.
- The paper isn’t loaded above the arrow on the left edge guide.
- The left edge guide is adjusted to fit your paper.
- Make sure that the printer is on a flat, stable surface that extends beyond the printer base in all directions. The printer will not operate properly if it is tilted.
Paper isn't ejected fully or is wrinkled

Try one or more of these solutions:

- If the paper doesn’t eject fully, press the \( \text{△} \) maintenance button, then open the printer cover and remove the paper. Also, check the Paper Size setting in your application or printer driver.

- If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack.

Note:
Store any unused paper in its original packaging in a dry area. See “Paper” on page A-1 for specifications.
Chapter 10

Consumable Products

Options

Consumable products

Ink cartridges

You can use the following cartridges with your printer.

<table>
<thead>
<tr>
<th>Ink Cartridge Type</th>
<th>Product Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black ink cartridge</td>
<td>T007</td>
</tr>
<tr>
<td>Standard capacity</td>
<td>T007</td>
</tr>
<tr>
<td>Light capacity</td>
<td>T010</td>
</tr>
<tr>
<td>Color ink cartridge</td>
<td>T008</td>
</tr>
</tbody>
</table>

Note:
The product numbers of ink cartridges may vary by location.

Media types

EPSON offers specially-designed media for ink jet printers to meet most high-quality printing needs.

Note:
For the latest information on the available media, visit our regional customer service web site. See “Regional Customer Services” on page B-1 for details.
EPSON Premium Ink Jet Plain Paper (A4)  S041214

EPSON 360 dpi Ink Jet Paper (A4)  S041059
EPSON Iron-On Cool Peel Transfer Paper (A4)  S041154

EPSON Photo Quality Ink Jet Paper (A4)  S041061
EPSON Photo Quality Ink Jet Cards (A6)  S041054
EPSON Photo Quality Ink Jet Cards (5 × 8”)  S041121
EPSON Photo Quality Ink Jet Cards (8 × 10”)  S041122
EPSON Photo Quality Self Adhesive Sheets (A4)  S041106
EPSON Ink Jet Note Cards A6 (with envelopes)  S041147
EPSON Ink Jet Greeting Cards 5 × 8” (with envelopes)  S041148
EPSON Ink Jet Greeting Cards 8 × 10” (with envelopes)  S041149

EPSON Matte Paper-Heavyweight (A4)  S041259

EPSON Photo Paper (A4)  S041140
EPSON Photo Paper (4 × 6”)  S041134
EPSON Panoramic Photo Paper (210 × 594 mm)  S041145
EPSON Photo Paper Cards (A4)  S041177
Note:
The availability of special media varies by location.
## Appendix A

### Printer Specifications

#### Printing

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing method</td>
<td>On-demand ink jet</td>
</tr>
<tr>
<td>Nozzle configuration</td>
<td>Monochrome (black) 48 nozzles</td>
</tr>
<tr>
<td></td>
<td>Color (cyan, magenta, yellow, light cyan, light magenta) 240 nozzles (48 [each color] × 5)</td>
</tr>
<tr>
<td>Resolution</td>
<td>Maximum 2880 dpi × 720 dpi</td>
</tr>
<tr>
<td>Print direction</td>
<td>Bidirectional with logic seeking</td>
</tr>
<tr>
<td>Control code</td>
<td>ESC/P Raster</td>
</tr>
<tr>
<td></td>
<td>EPSON Remote</td>
</tr>
<tr>
<td>Input buffer</td>
<td>32 KB</td>
</tr>
</tbody>
</table>

#### Paper

**Note:**
Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, EPSON cannot attest to the quality of any non-EPSON brand or type of paper. Always test samples of paper stock before purchasing large quantities or printing large jobs.
# Paper specifications

Single sheets:

<table>
<thead>
<tr>
<th>Size</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>A4 (210 mm × 297 mm)</td>
</tr>
<tr>
<td></td>
<td>A5 (148 mm × 210 mm)</td>
</tr>
<tr>
<td></td>
<td>Letter (216 mm × 279 mm)</td>
</tr>
<tr>
<td></td>
<td>Half letter (139.7 mm × 215.9 mm)</td>
</tr>
<tr>
<td></td>
<td>Legal (216 mm × 356 mm)</td>
</tr>
<tr>
<td></td>
<td>Executive (184.2 mm × 266.7 mm)</td>
</tr>
<tr>
<td></td>
<td>3.5 × 5&quot; (89 mm × 127 mm)</td>
</tr>
<tr>
<td></td>
<td>5 × 7&quot; (127 mm × 178 mm)</td>
</tr>
</tbody>
</table>

| Paper types        | Plain bond paper, special paper      |
| Paper types        | distributed by EPSON                 |

| Thickness          | 0.08 mm to 0.11 mm (0.003 to 0.004 inch) |
| Weight             | 64 g/m² (17 lb) to 90 g/m² (24 lb)      |

Envelopes:

<table>
<thead>
<tr>
<th>Size</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>No. 10 (104.8 mm × 241 mm)</td>
</tr>
<tr>
<td></td>
<td>DL (110 mm × 220 mm)</td>
</tr>
<tr>
<td></td>
<td>C6 (114 mm × 162 mm)</td>
</tr>
<tr>
<td></td>
<td>132 mm × 220 mm</td>
</tr>
</tbody>
</table>

| Paper types        | Plain bond paper, air mail           |

| Thickness          | 0.16 mm to 0.52 mm (0.006 to 0.02 inch) |
| Weight             | 45 g/m² (12 lb) to 75 g/m² (20 lb)      |
Index Cards:

Size | A6 (105 mm × 148 mm)  
5 × 8” (127 mm × 203 mm)  
8 × 10” (203 mm × 254 mm)

Paper types | Special paper distributed by EPSON

Transparencies, Glossy Film, Glossy Paper:

Size | A4 (210 mm × 297 mm)  
Letter (216 mm × 279 mm)  
A6 (105 mm × 148 mm) for glossy film

Paper types | Special paper distributed by EPSON

Self Adhesive Sheets:

Size | A4 (210 mm × 297 mm)

Paper types | Special paper distributed by EPSON

Photo Paper:

Size | A4 (210 mm × 297 mm)  
Letter (216 mm × 279 mm)  
Panoramic (210 mm × 594 mm)  
4 × 6” (102 mm × 152 mm)  
100 mm × 150 mm  
216 mm × 338 mm  
113.6 mm × 175.4 mm

Paper types | Special paper distributed by EPSON

Photo Stickers:

Size | A6 (105 mm × 148 mm) with 4 or 16 frames

Paper types | Special paper distributed by EPSON
Matte Paper-Heavyweight:

Size
- A4 (210 mm × 297 mm)
- Letter (216 mm × 279 mm)

Paper types
- Special paper distributed by EPSON

Note:
- Poor quality paper may reduce print quality and cause paper jams or other problems. If you encounter problems, switch to a higher grade of paper.
- Do not load curled or folded paper.
- Use paper under normal conditions:
  - Temperature 15 to 25°C (59 to 77°F)
  - Humidity 40 to 60% RH
- EPSON Photo Quality Glossy Film and Self Adhesive Sheets should be stored under the following conditions:
  - Temperature 15 to 30°C (59 to 86°F)
  - Humidity 20 to 60% RH

**Printable area**

Single sheets (including panoramic size) and index cards
Envelopes

Diagonal lines show printable area.

A: The minimum top margin is 3.0 mm (0.12").

When loading multiple sheets of EPSON Photo Quality Glossy Film, the minimum top margin is 30.0 mm (1.2").

B-L: The minimum left margin is 3.0 mm (0.12").

B-R: The minimum right margin is as follows:
- 3.0 mm (0.12") for single sheets and C6 envelopes.
- 7.0 mm (0.28") for DL envelopes.
- 28.0 mm (1.10") for No. 10 envelopes.

C: The minimum bottom margin is 14.0 mm (0.55").

*: You can extend the minimum bottom margin to 3 mm by selecting Maximum as the Printable Area setting on the printer driver's Paper menu (Windows) or in the Page Setup dialog box (Macintosh). However, print quality may decline in the expanded area. Before printing large jobs using this setting, print a single sheet to confirm printout quality.
**Note:** Always load paper into the sheet feeder short edge first. Load envelopes flap edge first with the flap side down.

**Ink Cartridges**

Black ink cartridges
There are two types of black ink cartridges. The Light Capacity ink cartridge (T010) contains half of the amount of ink as the Standard Capacity ink cartridge (T007).

Color                Black
Print capacity*      540 pages              Standard capacity
                    (A4, text at 360 dpi) (T007)
                    270 pages              Light capacity
                    (A4, text at 360 dpi) (T010)
Cartridge life       2 years from production date
                    (within 6 months after opening package, at 25°C [77°F])
Temperature          Storage:
                    -20 to 40°C (-4 to 104°F)
                    1 month at 40°C (104°F)
Transit:
                    -30 to 60°C (-22 to 140°F)
                    1 month at 40°C (104°F)
                    120 hours at 60°C (140°F)
Freezing:**          -16°C (3.2°F)
Dimensions          20.1 mm (W) × 60.0 mm (D) × 38.5 mm (H)
Color ink cartridge (T008)

Color Cyan, Magenta, Yellow, Light cyan and
Light magenta

Print capacity* 220 pages (A4, 360 dpi, 5% duty each color)

Cartridge life 2 years from production date
(within 6 months of opening the package at
25°C [77°F])

Temperature Storage:
-20 to 40°C (-4 to 104°F)
1 month at 40°C (104°F)

Transit:
-30 to 60°C (-22 to 140°F)
1 month at 40°C (104°F)
120 hours at 60°C (140°F)

Freezing:**
-18°C (-0.4°F)

Dimensions 49.1 mm (W) × 60.0 mm (D) × 38.5 mm (H)

* The figure given is based upon continuous printing after ink cartridge
replacement. The actual print capacity may vary, depending on how often
you use the print head cleaning function and how often you turn the printer
on.

** Ink thaws and is usable after approximately 3 hours at 25°C (77°F).

Caution:

EPSON recommends the use of original EPSON ink
cartridges only. Other products not manufactured by
EPSON may cause damage to your printer not covered by
EPSON’s warranties.

Do not use an ink cartridge if the date on the package has expired.
**Mechanical**

Paper feed method  Friction  
Paper path  Sheet feeder, rear entry  
Sheet feeder capacity  About 100 sheets at 64 g/m² (17 lb) paper  
Dimensions  
  Storage  
    Width: 450 mm (17.7 inches)  
    Depth: 257 mm (10.1 inches)  
    Height: 173 mm (6.8 inches)  
  Printing  
    Width: 450 mm (17.7 inches)  
    Depth: 452 mm (17.8 inches)  
    Height: 279 mm (11.0 inches)  
Weight  4.1 kg (9.0 lb) without the ink cartridges

**Electrical**

<table>
<thead>
<tr>
<th></th>
<th>120V Model</th>
<th>220-240V Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage range</td>
<td>99 to 132V</td>
<td>198 to 264V</td>
</tr>
<tr>
<td>Rated frequency range</td>
<td>50 to 60 Hz</td>
<td></td>
</tr>
<tr>
<td>Input frequency range</td>
<td>49.5 to 60.5 Hz</td>
<td></td>
</tr>
<tr>
<td>Rated current</td>
<td>0.4A</td>
<td>0.2A</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Approx. 17W (ISO10561 Letter Pattern)</td>
<td>Approx. 2.5W in standby mode</td>
</tr>
</tbody>
</table>

*Note:*
Check the label on the back of the printer for the voltage of your printer.
### Environmental

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Operation:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>10 to 35°C (50 to 95°F)</td>
</tr>
<tr>
<td></td>
<td>Storage:</td>
</tr>
<tr>
<td></td>
<td>-20 to 40°C (-4 to 104°F)</td>
</tr>
<tr>
<td></td>
<td>1 month at 40°C (104°F)</td>
</tr>
<tr>
<td></td>
<td>Transit:*</td>
</tr>
<tr>
<td></td>
<td>-20 to 60°C (-4 to 140°F)</td>
</tr>
<tr>
<td></td>
<td>120 hours at 60°C (140°F)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Humidity</th>
<th>Operation:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>20 to 80% RH</td>
</tr>
<tr>
<td></td>
<td>Storage:*,**</td>
</tr>
<tr>
<td></td>
<td>5 to 85% RH</td>
</tr>
</tbody>
</table>

* Stored in a shipping container
** Without condensation

### Safety Approvals

Safety standards:

- U.S. model  
  - UL 1950
  - CSA C22.2 No. 950
- European model  
  - EN60950
EMC:

U.S. model          FCC part 15 subpart B class B
European model      EN 55022 (CISPR Pub. 22) class B
                      EN 55024
                      EN 61000-3-2
                      EN 61000-3-3
Australian model    AS/NZS 3548 class B

**System Requirements**

Refer to the appropriate section below for the minimum and recommended computer system requirements necessary to use this printer.

**For Windows computers**

To use your printer, you need Microsoft® Windows® Millennium Edition, Windows® 98, Windows® 95, Windows® 2000, or Windows NT® 4.0 installed and the printer must be connected via a shielded, twisted-pair parallel cable. If you want to connect your printer to a USB port, you need a Windows 98 or Windows 2000 pre-installed PC equipped with a USB port and the printer must be connected via a standard, shielded USB cable.

Your computer should also meet the following system requirements.

<table>
<thead>
<tr>
<th>Minimum System Requirements</th>
<th>Recommended System</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For Macintosh computers

To connect this printer to Apple® Macintosh® computers, you must use a USB cable.

Your Macintosh must also meet the following system requirements.

<table>
<thead>
<tr>
<th>Minimum System Requirements</th>
<th>Recommended System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS 8.1</td>
<td>Mac OS 8.5.1, 8.6 or 9.x</td>
</tr>
<tr>
<td>14 MB of available memory</td>
<td>29 MB or more of available memory</td>
</tr>
<tr>
<td>16 MB of available memory</td>
<td>48 MB of available memory</td>
</tr>
<tr>
<td>when background printing is</td>
<td>when background printing is turned on.</td>
</tr>
<tr>
<td>turned on.</td>
<td></td>
</tr>
</tbody>
</table>
Note:

- The amount of available memory varies according to the number and kind of applications that are open. To see how much memory is available, choose About This Computer from the Apple menu and refer to the memory size (listed in kilobytes) under “Largest Unused Block” (1,024K=1 MB).

- The memory requirements above are for printing on Letter size paper. These requirements may vary depending on the size of the paper, the type of application you are using, and the complexity of the document that you want to print.

In addition to these system and memory requirements, you need 15 MB of free hard disk space to install your printer software. To print, you also need extra hard disk space amounting to about twice the size of the file that you want to print.
Appendix B

Customer Support

Technical Support Web Site

EPSON's Technical Support Web Site provides help with problems that cannot be solved using the troubleshooting information in your printer documentation. If you have a Web browser and can connect to the Internet, access that site at:

http://support.epson.net/StylusPhoto790

Regional Customer Services

If your EPSON product is not operating properly and you cannot solve the problem using the troubleshooting information in your product documentation, contact customer support services for assistance. If customer support for your area is not listed below, contact the dealer where you purchased your product.

Customer support will be able to help you much more quickly if you give them the following information.

- Product serial number
  (The serial number label is usually on the back of the product.)
- Product model
- Product software version
  (Click About, Version Info, or similar button in the product software.)
- Brand and model of your computer
Your computer operating system name and version

Names and versions of the software applications you normally use with your product.

For users in United States and Canada

EPSON provides technical assistance 24 hours a day through the electronic support services and automated telephone services listed below. If you wish to speak directly to a technical support representative, see your Printer Basics book for contact information.

Note:
For help using any other software on your system, see the documentation for that software for technical support information.

World Wide Web

From the Internet, you can reach EPSON Support at http://support.epson.com. At this site, you can download drivers and other files, look at documentation such as product brochures and user manuals, and access troubleshooting information.

EPSON Internet FTP Site

If you have Internet FTP capability, use your Web browser (or other software for FTP downloading) to log onto ftp.epson.com with the user name anonymous and your e-mail address as the password.

EPSON E-Mail Technical Support

To receive technical advice through e-mail, go to http://support.epson.com and complete the form under the troubleshooting tab, as requested.
Automated Telephone Services

A variety of automated help services are available 24 hours a day, seven days a week. To use these services, you must have a touch tone telephone and call (800) 922-8911.

EPSON Accessories

You can purchase ink cartridges, paper, manuals, and accessories from EPSON at (800) 873-7766 or visit our web site at www.epsonsupplies.com (U.S. sales only). In Canada, please call (800) 873-7766 for dealer referral.

For users in the United Kingdom and the Republic of Ireland

If you purchased your product in the UK or the Republic of Ireland, EPSON (UK) LTD provides a range of customer services and technical support.

Support Via the World Wide Web

- For information on the latest EPSON products, software drivers, online user guides, and answers to frequently asked questions:

  http://www.epson.co.uk

- To e-mail EPSON Technical Support:

  http://www.epson.co.uk/support/email/

- For a full list of EPSON Customer and Warranty Support services:

  http://www.epson.co.uk/support/

Support Via Telephone

Our Customer and Warranty Support teams can be contacted by calling 0870 163 7766 in the UK or 0044 0870 163 7766 from the Republic of Ireland. They can provide the following services:
Technical information on installing, configuring, and operating your EPSON products

Arranging for faulty EPSON products to be repaired within the warranty period

**Pre-Sales Enquiry Desk**

Our Enquiry Desk team can be contacted by calling 0800 220546 in the UK or 1 800 409132 from the Republic of Ireland, by faxing 01442 227271 in the UK or 0044 1442 227271 from the Republic of Ireland, and via e-mail at info@epson.co.uk. They can provide the following information:

- Pre-sales information and literature on new EPSON products (also available via our world wide web site at http://www.epson.co.uk)
- Where to purchase genuine EPSON consumables, accessories, and options

**For users in Australia**

EPSON Australia wishes to provide you with a high level of customer service. In addition to your product documentation, we provide the following sources for obtaining information:

**Your Dealer**

Don’t forget that your dealer can often help identify and resolve problems. The dealer should always be the first call for advise on problems, they can often solve problems quickly and easily as well as give advise on the next step to take.

**Internet URL http://www.epson.com.au**

Access the EPSON Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The site provides a download area for drivers, EPSON contact points, new product information and technical support (e-mail).
**EPSON Faxback service**

EPSON Faxback service will fax you the latest specifications for most EPSON products offered in Australia. Phone (02) 9903 9075 and the system will guide you through a number of choices before faxing the information to your fax machine.

**EPSON Helpdesk**

EPSON Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the Helpdesk can aid you in installing, configuring and operating your EPSON product. Our Pre-sales Helpdesk staff can provide literature on new EPSON products and advise where the nearest dealer or service agent is located. Many types of queries are answered here.

The Helpdesk numbers are:

- **Phone:** 1300 361 054
- **Fax:** (02) 9903 9189

We encourage you to have all the relevant information on hand when you ring. The more information you prepare, the faster we can help solve the problem. This information includes your EPSON product documentation, type of computer, operating system, application programs, and any information you feel is required.

**For users in Singapore**

Sources of information, support, and services available from Epson Singapore are:


Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), Sales Enquiries, and Technical Support via e-mail are available.
Epson HelpDesk (Phone: (065) 5863111)

Our HelpDesk team can help you with the following over the phone:

- Sales enquiries and product information
- Product usage questions or problem
- Enquiries on repair service and warranty

For users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact EPSON Hong Kong Limited.

Internet home page

EPSON Hong Kong has established a local home page in both Chinese and English on the Internet to provide users with the following information:

- Product information
- Answers to Frequently Asked Questions (FAQs)
- Latest versions of EPSON product drivers

Users can access our World Wide Web home page at:

http://www.epson.com.hk

Electronic bulletin board system

An electronic bulletin board system (BBS) is also available to obtain product information and the latest versions of product drivers. You can log on to the following number for the BBS service:

BBS: (852) 2827-4244
Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:

Phone: (852) 2585-4399
Fax: (852) 2827-4383

For users in Malaysia

Contacts for information, support, and services are:

World Wide Web (www.epson.com.my)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and Email Enquiries are available.

Epson Trading Shah Alam Head Office

Phone: 03 5191366
Fax: 03 5191281

For users in India

Contacts for information, support, and services are:

World Wide Web (www.epson.co.in)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), Products Enquiry, and Technical Query are available.
Epson India Bangalore Head Office:

Phone: 5321 266-70
Fax: 5581799/5321095
Help Desk Phone: -5321 625

For users in the Philippines

To obtain technical support as well as other after sales services, users are welcome to contact the EPSON Philippines Representative Office at the telephone and fax numbers below:

Phone: (632) 813-6552
Fax: (632) 813-6545
BBS: (632) 814-0595
The following definitions apply specifically to printers.

**application**
A software program that helps you carry out a particular task, such as word processing or financial planning.

**ASCII**
American Standard Code for Information Interchange. A standardized coding system for assigning numerical codes to letters and symbols.

**banding**
The horizontal lines that sometimes appear when printing graphics. This occurs when the print head is misaligned. See also *MicroWeave*.

**bit**
A binary digit (0 or 1), which is the smallest unit of information used by a printer or computer.

**brightness**
The lightness or darkness of an image.

**buffer**
The portion of the printer's memory used to store data before printing it.

**byte**
A unit of information consisting of eight bits.

**characters per inch (cpi)**
A measure of the size of text characters, sometimes referred to as pitch.

**CMYK**
Cyan (blue-green), magenta, yellow, and black. These colored inks are used to create the subtractive system array of printed colors.

**color matching**
A method of processing color data so that colors displayed on a computer screen closely match colors in printouts. A variety of color-matching software is available.

**ColorSync**
Macintosh software that is designed to help you get WYSIWYG (what you see is what you get) color output. This software prints colors as you see them on your screen.

**cpi**
See *characters per inch (cpi)*.
default
A value or setting that takes effect when the equipment is turned on, reset, or initialized.

dithering
A halftoning method in which dots are arranged in an orderly pattern. Dithering works best for printing images with solid colors, such as charts and graphs.

DMA
Direct Memory Access. A data transfer feature that bypasses a computer’s CPU and allows direct communication between a computer and peripheral devices (like printers), and between one peripheral device and another.

dpi
Dots per inch. The dpi measures the resolution. See also resolution.

drive
A memory device, such as CD-ROM, hard disk, or floppy disk. In Windows, a letter is assigned to each drive for easy management.

driver
A software program that sends instructions to a computer peripheral to tell it what to do. For example, your printer driver accepts print data from your word processor application and sends instructions to the printer on how to print this data.

economy printing
Printing in which images are printed with fewer dots to save ink.

error diffusion
Error diffusion blends individual colored dots with the colors of the surrounding dots to create the appearance of natural colors. By blending colored dots, the printer can achieve excellent colors and subtle color gradation. This method is best suited for printing documents that contain detailed graphics or photographic images.

ESC/P
Abbreviation for EPSON Standard Code for Printers, the system of commands your computer uses to control your printer. It is standard for all EPSON printers and is supported by most applications for personal computers.

ESC/P 2
The enhanced version of the ESC/P printer command language. Commands in this language produce laser-like features, such as scalable fonts and enhanced graphics printing.

Finest detail
This printer driver setting automatically makes your printout sharper and clearer, especially for text. Be aware that this may increase the time required for printing.
Flip Horizontal
This printer software setting automatically flips your printout, left to right.

font
A style of type designated by a family name.

gray scale
A scale of shades of gray from black to white. Grayscale is used to represent colors when printing with black ink only.

halftones
Patterns of black or colored dots used to reproduce an image.

high speed printing
Printing in which images are printed in both directions. This provides faster printing.

ICM (Image Color Matching)
The color matching method used by Windows Me, 98, 95, and 2000 to match the colors in your printout with the colors displayed on your screen.

initialization
Returns the printer to its defaults (fixed set of conditions). This happens every time you turn on the printer or reset the printer.

ink cartridge
Contains the ink your printer uses when printing.

ink jet
A method of printing in which each letter or symbol is formed by precisely spraying ink onto paper.

interface
The connection between the computer and the printer. A parallel interface transmits data one character or code at a time. A serial interface transmits data one bit at a time.

interface cable
The cable that connects the computer to the printer.

local printer
The printer connected to the computer’s port directly by an interface cable.

media
Materials upon which data is printed, such as envelopes, plain paper, special paper, and transparency film.

memory
The part of the printer’s electronic system that is used to store information (data). Some information is fixed and is used to control how the printer operates. Information that is sent to the printer from the computer is stored in memory temporarily. See also RAM and ROM.
**MicroWeave**
Printing in which images are printed in finer increments to reduce the possibility of banding and to produce laser-like images. See also *banding*.

**monochrome**
Printing with only one color of ink, usually black.

**nozzle**
Fine tubes in the print head through which ink is sprayed onto the page. Print quality may decline if the print head nozzles are clogged.

**operation check**
A method for checking the operation of the printer. When you perform a printer operation check, the printer prints the ROM version, code page, ink counter code, and a nozzle check pattern.

**parallel interface**
See *interface*.

**port**
An interface channel through which data is transmitted between devices.

**printable area**
The area of a page on which the printer can print. It is smaller than the physical size of the page due to margins.

**printer driver**
A software program that sends commands for using the features of a particular printer. Often shortened to “driver”.

**print queue**
When your printer is connected to a network, a waiting line in which print jobs that are sent to the printer while it is busy are stored until they can be printed.

**RAM**
Random Access Memory. The portion of the printer's memory used as a buffer and for storing user-defined characters. All data stored in RAM is lost when the printer is turned off.

**reset**
To return a printer to its defaults by turning the printer off and then back on.

**resolution**
The number of dots per inch used to represent an image.

**ROM**
Read Only Memory. A portion of memory that can only be read and cannot be used for data storage. ROM retains its contents when you turn off the printer.
**RGB**
Red, green, and blue. These colors, in phosphors irradiated by a cathode ray tube (CRT) monitor’s electron gun, are used to create the additive array of screen colors.

**serial interface**
See *interface*.

**Smooth Edge**
Improves the print quality of lower-solution images by smoothing jagged edges and lines. This setting has no effect on high-resolution images or on text.

**spool**
The first step in printing, in which the printer driver converts the print data into codes that your printer understands. This data is then sent directly to the printer or to the print server.

**spool manager**
The software program that converts print data into codes that your printer understands. See also *spool*.

**sRGB**
The color management method used to maintain color consistency between devices which adhere to the sRGB standard.

**Status Monitor**
The software program that allows you to check the printer’s status.

**subtractive colors**
Colors produced by pigments that absorb some colors of light and reflect others. See also *CMYK*.

**USB interface**
Universal Serial Bus interface. Enables the user to connect up to 127 peripheral devices (such as keyboards, mice, and printers) to the computer through a single, general-purpose port. The use of USB hubs allows you to add additional ports. See also *interface*.

**WYSIWYG**
What-you-see-is-what-you-get. This term is used to describe printout that looks exactly like it appears on screen.